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Hledate kvalitni studium?
Nabizime vam jej na Katedie konstruovani stroju

Katedra konstruovani stroju je jednou ze Sesti kateder Fakulty strojni na Zapadoceské univerzité v
Plzni a patfi na fakulté k nejvétsim. Fakulta strojni je moderni otevienou vzdélavaci instituci
uzndavanou i v oblasti védy a vyzkumu uplatfiovaného v praxi.

Katedra konstruovani stroju disponuje moderné vybavenymi laboratofemi s pocitacovou technikou,
na které jsou napf. studentlim pro studijni Ucely neomezené k dispozici nové verze prednich CAD
(Pro/Engineer, Catia, NX ) a CAE (MSC Marc, Ansys) systému. Laboratore katedry jsou ve vsedni dny
studentlm plné k dispozici napt. pro praci na semestralnich, bakalafskych ¢i diplomovych pracich, i
na dalSich projektech v rdmci univerzity apod.

Kvalita vyuky na katedre je Uzce propojena s celouniverzitnim systémem hodnoceni kvality vyuky, na
kterém se priibéziné, zejména po absolvovani jednotlivych semestrd, podileji vSichni studenti.

V soucasné dobé probiha na katedre konstruovani strojd vyznamna komplexni inovace vyuky, v rdmci
které mj. vznikaji i nové kvalitni u¢ebni materialy, které budou v nadchazejicich letech vyuzivany pro
podporu vyuky. Jeden z vysledk(l této snahy mate nyni ve svych rukou.

V rdmci vyuky i mimo ni maji studenti moznost zapojit se na katedre také do spoluprace s prednimi
strojirenskymi podniky v plzefiském regionu i mimo né&j. Rada student( rovnéz vyjizdi na studijni staze
a praxe do zahranici.
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1. GVOD DO SYSTEMU PRO/ENGINEER

UZIVATELSKE PROSTREDI SYSTEMU PRO/ENGINEER

> Uzivatelské prostifedi systému se zklada z nasledujicich ¢asti:
¢ Navigator - slouzi predevsim k zobrazeni stromu modelu (viz str.2)
e Stavovy radek - zobrazuje pokyny pro uzivatele k aktivované funkci, informace o problémech apod.
e Filtr pro vybér - umoziuje vybrat jen urcity typ entit (viz str.4 )
e Hlavni grafické okno - v tomto okné se zobrazuje model
« Dialogova lista - tvoii ovladaci rozhrani ptikaz{, zobrazi se pfi aktivaci nékterého z ptikazl (viz str.2)
e Horni nastrojova liSta - obsahuje nejc¢astéji pouzivané funkce k ovlddani zobrazeni, kopirovani apod.
« Bocdni nastrojova lista - je tvorena sety ikon, slouZi k rychlému spousténi prikazd (viz str.3 )
 Nabidkova lista - v jednotlivych menu naleznete veskeré funkce a prikazy

NABIDKOVA LISTA HORNI NASTROJOVA LISTA

| PRTO0D01 (Active) - Pro/ENGINEER Wildfire 4.0
File Edit “iew Insert Analysis Info  Applications Tools  Windd 30ProENGINEER.  Help

: - Brsaei s oo alo)qgl
Bo |G | AR

("1 PRTOOOL.PRT
7 BOKORYS
£7 PUDORYS
£F MARYS
B ]

% Insert Here
7 ##Extrude 1

D’j Flacement  Options  Properties
[0 @ |dk - [21651 ~] [ n= x

ﬁzselect a sketch, (IF aninternal sketch is preferred, the "Define” option can be Found in the Placement pane\‘)]
Sketch w

STAVOVY RADEK /

FILTR PRO VYBER




DIALOGOVA LISTA

» Volby této listy se méni v zavislosti na spusténém prikazu.

e Rozhrani dialogové listy pouziva vétsina nejpouzivanéjdich piikazl (extrude, revolve, hole, round,...), ale u n&kterych
1 prikazd je stale je$té pouzito starsi uZivatelské rozhrani — nabidkové menu (napt. protrusion sweep, protrusion blend)

D’j Flacement  Optionz  Properties

O] [k (s ¥ % C i X

w Vice informaci o nastrojové lité se dozvite v kapitole PROTAZENT (str.3) a ROTACE (str.3)

STROM MODELU (MODEL TREE)

> Ve stromu modelu jsou zaznamenany vSechny konstrukéni i pomocné prvky, které byly pouZity pro tvorbu daného modelu.
Strom modelu se vytvari odshora dold, ¢ili je z n&j patrna chronologie vytvareni modelu.

»  Strom modelu se Ize pouzit napfiklad k témto Gcelim: .
e Volba prvkd Ch

R3] &R

Show * ][ Seftings ]

e Pfejmenovavani prvk{ [
e Vyhledavani
 Modifikovani prvkd 7 OBTMKA.PRT
e Zobrazovani informaci o konstruk¢nich prvcich L7 BOKORYS

e Zména poradi prvkd (kliknutim na prvek a jeho pfetdhnutim na jinou pozici ve L7 PLDORYS
Stromu modelu) £7 NARYS

omu model s

e Vkladani prvku a komponent ok Revolve 1

[:2] Pattern 1 af YYKROJENT i

[:] Pattern 2 of Extrude 9

T Cosmetic id 6400

3 Round 1

“J Round 2

4 Round 3

3 Chamfer 1

) Round 4

& Insert Here

e Otevirani komponent, které jsou soucasti sestavy

[

» Nastaveni zobrazovani jednotlivych prvk{ ve stromu Ize provést pod tladitkem pfikazem Tree Filters...
> V zobrazeném dialog Ize napfiklad zobrazit potlacené prvky (Suppressed Objects) tim, Ze je zaskrtneme.
> Déle na zélozce General miZeme povypinat zobrazeni pomocnych prvkd, skic, zaobleni, & kosmetickych prvk{

;

Display Feature Types
Features

| General | Cabling | Piping | MFG | Mechanism |

[[] Placement folder 77 Datum Plane
[[] Annotations
i # Datum Ads
[C] Suppressed Objects ‘ ~~ Curve
Incomplete Objects % Datum Point
Bxcluded Objects 2¢x Coordinate System
Blanked Objects 2
4 : ~2 Round
[[] Envelope Components Z
[[] Copied References ‘ El ) s Fovditobe
| V] P Cosmetic

—
M)

iOK i Apply | | Close




BOCNI NASTROJOVA LISTA

NA UROVNI SESTAVY

NA UROVNI SOUCASTI

/7 =—— pomocna rovina (plane)
/I e—— pomocna osa (axis)
/~ e—— kiivka (curve)

« % ®— body (points)

;\,{x e—— souradny systém

*
2% ¢ analyza (analysis)

l:]] e—— poznamka (annotation)

_153 o« pridat soucast (assemble)
% e—— nova soucast (create)
[” e——dira (hole)

o—— zkoseni (draft)

e—— zaobleni (round)

*— srazeni (edge chamfer)

D;] e— protazeni (extrude)
:3 «— rotace (revolve)
:le —— tazeni (sweep)
77 e—— (boundary blend)

[—] = (style)
e—— zrcadleni (mirror)
e—— sloucit (merge)
*— odriznout (trim)

*— pole/vzor(pattern)

/7 e—— pomocna rovina (plane)

I/ e—— pomocna osa (axis)

/~" e—— ktivka (curve)

| o e — body (points)

Y, v ’ s
- » «—— soufadny systém
Lﬁ:} e« analyza (analysis)

Vet
{j/ o—— reference

Cly e— poznamka (annotation)
g4

[ «e——dira (hole)

(1) e« skoFepina (shell)

. e—— ebro (rib)

_d o—— zkoseni (draft)
) &= zaobleni (round)

2 «—— sraZeni (edge chamfer)
&) — vytazeni (extrude)
b o—— rotace (revolve)
< =— taZeni (sweep)
77 «— (boundary blend)
(] —— (style)
e—— zrcadleni (mirror)

e—— sloucit (merge)
e—— odfiznout (trim)

e—— pole/vzor(pattern)




FILTR PRO VYBER ENTIT

>

Umoznuje zvolit druh entity, ktery Ize vybirat v hlavnim grafickém okné.

» Typ a pocet voleb filtru zavisi na rezimu, ve kterém pravé pracujete.

REZIM SOUCAST (PART)

jakykoliv dostupny druh entity

Geometry e

Dimension

koty

fkirp

Constraint

geometrické vazby

Al

REZIM SESTAVA (ASSEMBLY)

jakykoliv dostupny druh entity

Pats e soucasti

Features . prvky (vytazeni, rotace, dira...)
Geometry e hrany, plochy, body

Datums e pomocna geometrie (osy,plochy,body)
Quilts o povrchy

Annotation e poznamky

REZIM VYKRES (DRAWING)

Drawing ftem and View jakakoliv dostupna entita skicare nebo pohled

Drawing ftem ® jakakoliv dostupna entita skicare

Note and Dimension ®—————— Poznamky a koty

Balloon ® pozice

Component ® komponenw

Datum Plane ® roviny

Datum Axis ® os,y

Dimension ® kOtY L

Direction Amow © smerove Sipky

Draft Datum Plane

Draft Datum Ads

Draft Entty ® , ,

Drawing View ® vykresove pohledy

Edge ® hrany

Feature ® prvky

Saface * povrchy )

Geometric Tolerance ®™——— geometrické tolerance
v ° text

Individual Text © ]

OLE Object ® OLE objekty

Note ® poznamky

Snap Line ® pomocné primky pro uchyceni

Surface Finish ®

Symbol ®

Table © tabulky

Table Cell ® bufiky tabulek

Table Column © sloupce tabulek

Table Row © fadky tabulek

X-Section ® fezy




VYBER ENTITY

>

Entitu zvolime kliknutim levym tlacitkem mysi v hlavnim grafickém okné nebo ve stromé. Paklize se pfi prvnim kliknuti
oznadi jina entita, neZ ta, kterou chceme vybrat, Ize vyuZit nasledujicich postup(:

e PodrZenim pravého tlacitka mysi a vybranim Next / Previous z se oznaci dalsi / pfedchozi entita na pozici kurzoru

e PodrZenim pravého tlacitka a vybranim Pick From List Ize vyvolat seznam vSech entit na pozici kurzoru a z nich
vybrat poZzadovanou entitu

e Kliknutim pravého tlacitka Ize vybrat dalsi entitu na pozici kurzoru

(-

revious
Pick From List

M Pick From List [X]

OBJIMKAPRT
TE36.PRT

SESTAVAASM !

(3] () (o] oesl]

VICENASOBNY VYBER ENTIT

>
>

Pro vybér vice jak jedné entity mizete pouzit kldvesu CTRL

Pro zobrazeni nebo odstranéni vybranych entit miZete pouZit seznam vybranych entit, ktery zobrazite dvojkliknutim
v oblasti znazornéné na obrazku cervené.

B Selected ltems

kLIKAPRT
SMEK.PRT
SITKO.PRT
OBJIMKAPRT

%]

—>

I 4 zelected I

| Srnart
1

Remowe

Cloze




ZAKLADY MANIPULACE S MODELEM

» Otaceni, posouvani a pfiblizovani /oddalovani modelu jsou tfi zakladni funkce systému.

POSUNUTi MODELU NA OBRAZOVCE

1. Stisknéte a pridrzte klavesu SHIFT.
2. Stisknéte a podrzte prostredni tlacitko mysi.
3. Pohybem mysi posurite model.

PRIBLIZIT/ODDALIT MODEL NA OBRAZOVCE

1. Stisknéte a pridrzte kldvesu CTRL.
2. Stisknéte a podrzte prostredni tlacitko mysi.
3. Pohybem mysi dolll pohled pfiblizite, pohybem nahoru oddalite.

\l/ K priblizeni/oddaleni modelu Ize s vyhodou vyuzit kole¢ko mysi. Rolovanim dold pohled pfiblizite a naopak.

ZVETSENI VYBRANE CASTI MODELU PRES CELOU OBRAZOVKU

Stisknéte tladitko * na nastrojové listé v horni nastrojové listé.

Pomoci levého tlac¢itka mysSi oznacte roh oblasti, ktera se ma zvétsit nebo zmensit.
Drzte levé tlacitko mysi, potahnéte mysi a oznacte oblast ke zvétSeni ¢i zmenseni.
Uvolnéte levé tlacitko mysi.

PUNE

NATOCENI MODELU

1. Stisknéte a podrzte prostredni tlacitko mysi.

2. Naslednym pohybem vyvoldte pootaceni modelu.

> Jestlize je aktivovana ikona |t|5pin center bude se model otacet kolem stfedu télesa zobrazeného v hlavnim grafickém
okné touto ikonou. Paklize tato ikona aktivovana neni, bude se model otacet kolem bodu, nad kterym stisknete prostredni
tlacitko mysi.

ZMENA ZOBRAZENI MODELU

3 .

> Standardné je zobrazeni modelu nastaveno na vystinované

1-6




>

Stiskem tlacitka B zménite nastaveni na zobrazeni bez skrytych hran (No Hidden).

>

>

1-7




ORIENTACE MODELU A VYTVARENI POHLEDU

»  Zakladni pfikazy pro orientaci modelu naleznete v menu View-Orientation

B PRT0001 (Active) - Pro/ENGINEER Wildfire 4.0

File Edit BUEEN Insert Analysis Info  Applications Tools  ‘Window  3DxProEMGIMEER  Help

0O I_r,ERepaint Chrl+R sy o | [Z]

Shade o

a
= % a Render Window
[ Show Realtirme Rendering

Crigntation Standard Otientation @ ShriEr ISO pohled
[JPRTOOC  visibility ¥ 5 Previous e Predchozi pohled
g 33 Gl refic ® V hlavnim okné se zobrazi cely objekt
77 MA gl View Manager [* Reotient... ® Nastaveni orientace modelu (viz dale)
5{“ C5i% Tone Ackive Annatation Crientation
¥ Ins @ Color and Appearance Orient Mode @ Maod pro otaceni modelu
#nnotation Origntation

v s "+
PRIKAZ REORIENT &

>  Slouzi k vytvoreni vlastnich pohledl na model. Tyto pohledy je poté mozno ukladat a mazat pod polozkou Saved Views.

Standard Orientation A
Default Orientation

BOKORYS

DOLNI

MNARYS

PRAWY v
[ Set ] [ Save] [Delete]

> Pohled Ize vytvofit pomoci nasledujicich typl dialogl:

ORIENT BY REFERENCE

> Pohled je definovan zad&nim dvou referencnich prvkd (roviny, osy nebo rovinné plochy) a jejich polohy na vytvareném
pohledu.

® Orientation

Tvpe

| Orient by reference

Options

Fieference 1
| Frant
Back
] | o
Reference 2 Eottom
Left
| | Right
Vertical axis
Harizontal asis
[ ok ] [cancel] [ undo |

> Tlacitkem se Ize vratit ke vychozi orientaci.
> Definovany pohled uloZite tlacitkem [3==],




DYNAMIC ORIENT

» Pohled Ize definovat pomoci posouvani modelu v horizontalnim a vertikalnim sméru, rotaci kolem vsech tfi os a zoomem
modelu.

B Orientation

i J 0.000
Jsv J 0.000
xJe [ o

Dynamic update

A (4 (4

[ Ok, ] [Cancel] [Undo]

> Tlacitkem se Ize vratit ke vychozi orientaci.
> Definovany pohled uloZite tladitkem [Sz-=],

PREFERENCES

> Na této zdlozce Ize nastavit stied otaceni ( o spin center) vybranim jedné z péti moznosti:
e Stfed modelu
e Stfed obrazovky
e Bod nebo vrchol
e Hrana nebo osa
e Souradny systém

>  Poté kliknutim na a zadanim zadanim zadané entity prenastavite stfed otaceni modelu.

E Orientation
Type

Spin Center
(%) Model center
() Screen center
O Paint or vertex
() Edge or axis
() Coordinate system

Drefault Orientation
Trimetric: v

[ Ok, ] [Eancel] [Undo]




ZAHAJENI PRACE

NASTAVENI PRACOVNIHO ADRESARE (WORKING DIRECTORY)

> Je to adresar, ze kterého se budou nacitat a do kterého se budou ukladat soubory.
>  Pracovni adresar Ize nastavit nasledujicimi zpGsoby:
e Ve vlastnostech ikony ke spusténi programu Pro/Engineer v kolonce Spustiv v:
e V menu File > Set Working Directory...

e Ikona ™ v horni nastrojové listé

ProE WF4 - vlastnosti

Pro/ENGIMEER Wildfire 4.0

Edit Wiew Insert Analvsis Info

Obecné | Zastupce |Kompatibilita Zahezpedeni

i (5 Mew... Chrl+h
@ ProE W4 .
[=F Open... Chrl+0
e i [ Sek Working Directory ... ]
Umigténi cile:  bin
cit |"D:\Ptc\proeWiIdfire 4.0%bin\pros exe” | 2
[ Spustit v |E:\workdil\ |]
Klavesova f
zhratka: | nen! |
Spustit: |V narmélnim okné “ |
..... .
KomentaF: | | i
[ Najitcil. | [ Zméntikonu.. | [ Upfesnit. |
I ak. l [ Starno ] [ PouZit
OTEVRENi SOUBORU
=
> Prikazem v menu File > Open nebo ikonkou v nastrojové listé.
e Preview « s _ - , ) ,
»  TlacCitkem Ize zobrazit nahled souboru. V pravo nahore je policko Search.. Timto Ize filtrovat zobrazené soubory

podle zadaného textu. Toto je vhodné pouzit zvlasté pfi praci ve vétsich sestavach, ve kterych je v jednom adresari

umistén vétsi pocet soubord.
= File Open |

@.\._ PR <« Data[E:) » grach » TUTORIALYPROJEKT » MLYNEK » VZOR v Searc
28 ~ 77 Taok v

Comman Falders klika.drw sestava.diw
] In Siession [ Klikaprt 7] o]
T} Desktop [ Iozisko.prt 71 snek.prt

fuz. prt sroub. prt
2 My Documents o P o "

abjrkadme [ sroub_klprt
[ objmkapt  [] te36.prt
Natwork Meighborhoad 1 osickaprt telo.drw
A KNIHOVNY-STaNDARDS () podiozka.prt

Templates [ rukojet.prt
:! sestava.asm

¥ Waorking Directom

System Formats
Uszer Formats

2 Favorites

File name: sitko prt Date modified: 30-Apr-07 07:54:34 Pk Freview ¥

File name: | sitio. prt | Tvpe| Pro/ENGINEER Files [, |

Falder Tree -

[ Open 'HDpanHep...][ Cancel




VYTVORENI NOVEHO SOUBORU

» Prikazem v menu File - New nebo ikonkou

®d
oM
O
O
O B3
(ORE!
o+
O H
O 4

Mame

N

Azzembly

M ahufacturing
Drawing
Format

Fieport
Diagram
Layout
Markup

sitko

Common Mame

Usze default template

v nastrojové listé.

Sub-type
(* Salid
() Compasite
() Sheetmetal
) Bulk

ZAKLADNI TYPY SOUBORU V SYSTEMU PRO/ENGINEER

>  Systém Pro/Engineer pouziva tii zékladni typy soubord:

e ¥ prt — Part - Je to soubor dilu (jedné konkrétni soucastky). Tento soubor obsahuje vSechny informace o geometrii
dilu a je jako jediny schopen byt spusté&n samostatné bez daldich potfebnych souboord.

e *.,asm - Assembly - Je to soubor sestavy vzniklé sestavenim nékolika dil& a obsahuje pouze informace o zplsobu

poskladani jednotlivych dill. Tento soubor NEOBSAHUJE INFORMACE O SAMOTNYCH DILECH SESTAVY. Proto je

nutné mit k dispozici také soubory jednotlivych soucasti sestavy.

e *.drw - Drawing - Je to soubor vykresu dilu nebo sestavy. Obsahuje pouze informace o vykresu, pohledech, _
zobrazenych kotach, razitkach, rameccich, ale NEBOSAHUJE INFORMACE O SAMOTNE SOUCASTI/SESTAVE.

>  Systém pfi ukladani souborl neprepisuje plvodni soubor, ale vytvaii vidy novou koncovku. Napfiklad nazvete-li soubor
kladka.prt, uloZi se pfi prvnim ukladani jako kladka.prt.1, pfi dalSim ulolZeni jako kladka.prt.2 a tak dale...

» Tento zplsob automatického pFejmenovavani souborli umoziiuje €asté ukladani souboru (kterého se v systému
PRO/ENGINEER hojné vyuziva vzhledem k omezené funkci tlaCitka zpét) a jednoduché navraceni k jedné z predchozich

verzi souboru, paklize model zhavaruje.

> Nevyhodou tohoto zplisobu ukladani je neustéle se navysujici pocet souborll v pracovnim adresafi a v&t&i naroky na volné

misto na disku.

> Paklize je model hotovy a jsme si jisti, Ze se jiz nebudeme potfebovat vratit zpét ke starsi verzi modelu, Ize model procisti
smazanim starsich verzi souborl a tim zvysit pfehlednost a snizit obsazeny prostor na disku. Toto Ize provést ruéné& nebo

vyuzit specializované utilitky PROBackUp-Purge.

t




2. ZPUSOBY EDITACE PRVKU

VZTAH RODIC-POTOMEK

V systému Pro/Engineer jsou prvky do stromu v pribéhu prace uklddany odshora dold. Prvek vytvoreny dfive je ve stromé
umistény vyse a nebude “nic védét” o prvku, ktery je umistény pod nim, tzn. Ze nikdy prvek umistény ve stromé vyse
nemiiZe byt zavisly na prvku, ktery je ve stromé umistén nize.

Jestlize napfriklad vytvofime diru skrz vse (Thru All) a nasledné poté vytvorite protazeni prochazejici touto dirou, neovlivni tato
dira nové vytvorené protaZeni, protoze kazdy prvek mlize ovlivnit pouze dfive vytvorené prvky, které jsou umisténé vyse ve

stromé.
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Aby dira ovlivnila i nové vytvorené protazeni, musime protazeni umistit vySe do stromu, nez je prvek diry. To Ize provést dvéma
zplsoby:
o MdZeme se presunout v historii zpét pired vytvoreni prvku diry a zde vytvorit prvek protazeni
o MdZeme néasledné po vytvoreni protaZeni tento prvek presunout pred prvek diry
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Prvek protaZeni nesmi byt zavisly na prvku dira(nesmi byt jeho potomek), aby bylo mozné jej pfesunout pred diru.

"

~
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Zavislé jsou vzdy prvky umisténé ve stromé nize na prvcich umisténych ve stromé vyse, Cili prvek nové vytvareny mbize byt
zavisly na jiz vytvofeném prvku a pravé tuto zavislost je nutné pfedem promyslet, abychom se vyhnuli ne¢ekanym problémdm
pfi modifikaci geometrie.

OVLADANI VZTAHU RODIC-POTOMEK

»  Zde jsou popsany obecna doporuéeni, kterd mohou udetfit spoustu préce a problém& pti modifikovéni modelu:

e PouZivejte vychozi pomocné roviny (PUDORYS, NARYS a BOKORYS) a osy jako skicovaci a referenc¢ni roviny radéji
neZ geometrické prvky. Vyhnete se tim provézanosti jednotlivych prvki mezi sebou a naslednym havariim pfi
modifikaci nebo smazani rodiCovského prvku.

e Vybirejte za reference spise stény modelu nez hrany, protoze hrany konstrukéniho prvku se méni daleko Castéji.

¢ Rozmyslejte nad vhodnou volbou referenci, nad tim kterou sténu zvolite za skicovaci nebo referenc¢ni a zdali je tato
sténa tou nejlepsi volbou.

e V reZimu skicare pri vybéru referenci model natocte, abyste si byli jisti, Ze nezvolite misto stény hranu apod.




PROVADENI ZMEN V MODELU — EDITACE PRVKU

>

Po vytvoreni prvku Ize prvek riznymi zplsoby editovat, k editaci prvk{ vyuzijeme strom modelu. Klikneme-li na prvek ve
stromé pravym tlacitkem, objevi se kontextova nabidka, kterd ndm umozni pfistup k informacim o prvku a jeho Upravam.

Delete

Group .,

Suppress o Delete - smazani prvku

Rename e Suppress - potlaceni prvku

0 ¢ Rename - zména nazvu prvku

Edit Definitian o Edit - editace rozmé&rd prvku

Edit References o Edit Definition - pFedefinovani prvku
Create Driving Dimension AE ¢ Edit References - zména referenci prvku
Pattern...

Sefup Noke 4

Info 3

Hide

Edit Parameters

DELETE — SMAZANI PRVKU

> Pomoci volby Delete z kontextového menu lze prvek smazat, smazany prvek neni mozné obnovit nebo vratit do modelu.
>  Paklize pvek, ktery chceme smazat, ma potomky (prvky, které jsou na mazaném prvku zavislé), je nutné urcit, co se se
zavislymi prvky stane po smazani tohoto prvku. Vyskoci nasledujici hlaska:
E Delete
P | Highlighted Features wil be DELETED.Please confirm
\._‘/ or select "Options" for advanced options,
[ Ok ] [ Cancel ] [Options =
>  Kliknéte na tladitko pro zobrazeni pokrocilejsich voleb. B Children Handling (=13
» V zobrazeném dialogu jsou vypsani potomci smazaného prvku a pod kolonkou S Gt i
Status Ize u kazdého prvku zvolit, co se s nim ma stat: Children
« Delete - smazat prvek Object Status
. . ) v Ly % Sketch 2
+ Suspend - ponechd prvek v modelu, nicméné vzhledem k tomu, Ze rodi¢ Detete
prvku byl smazan, je nutno prvek predefinovat. Konstrukéni prvek pfi #3 Sketch 5 Delste
regeneraci zhavaruje, objevi se okno Failure Diagnostics a nabidka 7 Swept Blend 1 Delote

Delete
Je vyhodné se havariim vyhnout tim, Ze predefinujeme reference ptikazem sk Revalve 2 Delste
1 Redefine, Edit Definition nebo Replace References drive, nez k havarii i
prvku dojde.
oK

RESOLVE FEAT. Dokud neni chyba odstranéna, neni mozné pokracovat v o
konstrukci modelu. A Cosmetic id 627 Delste

DFD Rewvalve 1

w Vice informaci o RESENI HAVARII se v kapitole RESENI ZHAVAROVANYCH PRVKUJ

>

Kliknutim pravym tlac¢itkem na prvek zobrazite kontextovou nabidku, kterd nabizi nasledujici moznosti:

Delete
¢ Replace References - nahradit mazany prvek jinym referencnim prvkem

¢ Redefine - predefinovani prvku (obdobné prikazu Edit Definition)
¢ Show References - vyznaci reference, které je nutno zménit, aby mohl prvek byt zachovan
e Info - dalsi informace o modelu a prvku

Suspend

Replace References

Redefine
Show References

Info 4




SUPPRESS — POTLACENI PRVKU

» Pomoci volby Suppress Ize prvek potlacit (docasné odstranit z modelu) s moznosti obnoveni v pfipadé potfeby.

@ Nazornou ukazku funkce Suppress naleznete ve 3.cvi¢eni na str.14

>  PFi potlaceni prvku(rodice), na ktery jsou navazany dalsi prvky(potomci) nastava obdobna situace jako u pfikazu Delete.
Opét mame dvé moznosti:

e Prvky je mozno potlacit spolu s rodi¢em a poté je spolu s rodi¢em opét obnovit

¢ Mame moznost prvky predefinovat (Redefine) nebo nahradit reference na potlatovany prvek jinymi referencemi
(Replace References)

RENAME — PREJMENOVANI PRVKU

> Dvojim poklepanim na prvek ve stromé nebo vybranim volby Rename z kontextové nabidky prvek pfejmenujeme.

J— o

& Nazvy prvkd nesmé&ji obsahovat mezery ani te¢ky (pouzivejte podtrzitko”_") a zvlastni znaky (napi @,!,”,* apod.)
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EDIT — EDITACE ROZMERU PRVKU

> Volbou Edit z kontextového menu u vybraného prvku Ize ménit rozméry prvku a koty skici pouzité pro prvek.

aa
> Poklepanim na kdtu lze prepsat rozmér. Zmény v geometrii se projevi az po regeneraci modelu stiskem tlacitka 8=,
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EDIT DEFINITION — PREDEFINOVANI PRVKU

Pomoci pfikazu Edit definition se presuneme v historii zpatky do stavu, kdy byl editovany prvek vytvoren.
VSechny prvky vytvorené po tomto editovaném prvku nebudou viditelné.
V editovaném prvku mdZeme ménit napfiklad: smé&r protazeni, velikost protazeni, zakonéeni protaZeni atd.

YV V V V

MdZeme se také prepnout do skicare a upravit skicu.

|

[ s Uptic
Ofa [&-Mew 1% 2 ¢ Il Mev [v] X

Placerment  Options  Properties

POZOR! Neopatrné Gpravy skici mohou zplisobit smazani referenci, co? bude mit za nasledek problémy pii regeneraci
modelu. Poté je nutné predefinovat zavislé prvky (potomky) tohoto prvku.

EDIT REFERENCES — ZMENA REFERENCI PRVKU

> Zména referenci prvku miZe byt vyhodnym Fedenim v situaci, kdy potfebujeme odstranit nebo potlacit prvek-rodi¢ a
chceme zachovat prvek-potomek. Musime odstranit vazbu mezi rodi¢em a potomkem, coz se da provést pomoci piikazu
Edit References zaménou reference za jinou.

UKAZKA POUZITi PRIKAZU EDIT REFERENCES
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> Budeme ménit skicovaci rovinu prvku protazeni dutého valce, ve kterém jsou vyvrtany diry.
>  Pomoci zmény jedné referenéni roviny se modifikuje ptislusny prvek véetné viech jeho potomkd.
> Spustime prikaz Edit References z kontextového menu, které se zobrazi po kliknuti pravym tlacitkem na prvek ve stromé.

DTM1

> Na otazku, zda se chceme v historii vracet zpét zvolime YES, abychom zabranili tomu, Ze nova reference bude ve stromu

nize, nez prvek, ktery editujeme, coz by vedlo k chybé.

e Do vou want to roll back the model? (855

> Tento prikaz pouziva starsi uzivatelské rozhrani zvané Menu Manager,modie zvyraznény text je nadpis, ¢erné vyznaceny
text je zvolena volba. Zde je popis jednotlivych pfikaz{ tohoto menu:

Menu Manager

- RERCUTE REFS
¢ Reroute Feat - postupné projit vSechny reference a postupné je vyménovat nebo ponechat

Reroute Feat . . Y
* Replace Ref - vybrat jednu referenci a zameénit ji za novou

¢ Done/Return - navrat z tohoto menu

Replace Ref
Done/Return
RERCUTE
Alternate L.
e Alternate - vymeéna reference za jinou

e Same Ref - zachovat plvodni referenci

¢ Ref Info - informace o referenci

¢ Done - potvrdit zmény

¢ Quit Reroute - ukonceni prikazu Reroute

Same Ref
Ref Info
Done
Quik Rerouke

RER.CUTE SEL
e Select - vybrat referenci

¢ Make Datum - vytvofit pomocnou rovinu
Make Dakurmn

» V Menu Manageru vybereme Replace Ref.
> Nabidky Menu Manageru se zméni, nechame je ve stavu na obrazku.

Menu Manager,

w REROUTE REFS
Reroute Feat
Replace Ref
Done/Return

w SELECT TYPE

Feature

Indiv Entity




» Vybereme nejprve skicovaci rovinu DTM1 a poté rovinu DTM5, ktera nahradi rovinu DTM1.

Menu Manager

w RERCUTE REFS
Reroute Feat
Replace Ref
Done/Return

w REF RERCUTE

o Sel Feat - presmérovat reference ve vybraném prvku
¢ All Children - pfesmérovat reference ve vybraném prvku a jeho potomcich

Sel Feat
&l Children

» Vybereme All Children.

>  Zkontrolujeme smé&r Sipky, éernd Sipka udava smér plvodni skicovaci roviny DTM1 a ¢ervend Sipka smér roviny DTM5.
>  Smér roviny DTM5 Ize zménit kliknutim na Flip.
> Potvrdime provedeni zamény referenci kliknutim na Okay.

Menu Manager

w REROUTE REFS
Reroute Feat
Replace Ref
Cone/Return

w DIRECTICN

Flip
Okay
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> Vysledkem zamény skicovacich rovin je upravené téleso:

POUZIVANI HISTORIE

> Kromé& Upravy prvkl ve stromé& popsané v minulé kapitole je moZné a ¢asto velmi vyhodné vracet se v historii zpé&t.
>  Pouziti historie je pfehledné a zabrani se problémim s necht&nymi referencemi na jiné prvky

>  Pozici v historii, ve které se pravé nachazime , znaci znacka e i

serk Here

>  Posunutim této znacky ve stromé nahoru se vratime zpét v historii, jak je zobrazeno na obrazcich.
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3. POMOCNE GEOMETRICKE PRVKY (DATUMS)

UKAZKA

Vytvoreni pomocnych geometrickych rovin je v nékterych pfipadech nezbytné, paklize nelze pouzit standardni pomocné
roviny (NARYS, BOKORYS, PUDORYS).

Napriklad pfi vytvareni diry pro pero na hrideli se bez vytvoreni pomocné roviny neobejdeme, jelikoz valcova plocha hridele
nemdUze byt pouZita jakoZto skicovaci rovina.

DTM1

> Pro vytvoreni protazeni na obrazku je také nutno vytvorit dalsi pomocnou rovinu.

DRUHY POMOCNYCH GEOMETRICKYCH PRVKUO

> NejdlleZit&j$i pomocné prvky:

¢ Pomocné roviny

¢ Pomocné osy

¢ Pomocné body

> Dalsi pomocné prvky (kfivky, soufadné systémy)




POMOCNE ROVINY

>

PFiklady pouziti pomocnych rovin:

e Jako skicovaci roviny pro vytvareni skic

e Jako referencni roviny ve skicafi

o Jako referencni roviny pro tvorbu dér a v sestavach

o Jako referencni roviny pro zrcadleni, kopirovani, vytvareni fezl atd.

VYTVARENI POMOCNE ROVINY

>
>

Kliknéte na ikonu = nebo v menu Insert->Model datum->Plane...

Objevi se dialogové okno Datum Plane.

= DATUM PLANE X

Placemert | Digplay | Properties
Feferences > Na jednotlivych zdlozkach Ize nastavit:
¢ Placement - umisténi roviny

e Display - smér a velikost roviny
¢ Properties - nazev roviny

>  NejddleZit&jsi je tedy zéloZka Placement, ve které volite reference a podminky pro
umisténi pomocné roviny.

Cancel

> Jako reference mlzete vybrat nasledujici entity:
e Osa (axis)
e Hrana (edge)
e Krivka (curve)
e Bod/vrchol (point/vertex)
¢ Rovina (plane)
e Valec
e Systém soufadnic (coordinate system)
>  KdyZ vytvaiite pomocné roviny, je nutné nastavit podminky k referenc¢nim prvkim.

ZAKLADNI TYPY PODMINEK
ANGLICKY CESKY POPIS
THROUGH Skrz Prochazejici bodem, rovinou, pfimkou...
NORMAL Kolmost Kolmo na osu, hranu, rovinu...
PARALLEL Rovnobéznost Rovnobézné s osou, hranou, rovinou...
OFFSET Odsazeni Rovnobézné s osou/hranou/rovinou v zadané vzdalenosti...
TANGENT Tecnost Tecné k valcové plose...




TABULKA KOMBINACI PODMINEK

>

»

Tato tabulka uvadi vSechny platné kombinace podminek, které Ize pouzit k vytvoreni nové pomocné roviny. Napfiklad
rovinu Ize definovat normalovou pfimkou a bodem, ¢ili v tabulce u kombinace NORMAL ROVINA a THROUGH BOD/VRCHOL

je zobrazena znacka ‘/ , kterd zna¢i PLATNOU KOMBINACI PODMINEK. Tam, kde tato zna¢ka neni, nelze kombinaci
téchto podminek pouzit k definovani roviny.

T = |
e JE|3|z
0 =20
14 <
14 4 -
I 9 < <
= Zla | F
KOMBINACE PODMINEK o
5 < | <
&) &)
g 5] 2 £ 8
2| 2|/ 8] g| €
a x x >
@)
m

ST XN |HRANA 7 OSA [ KRIVKA

HRANA / OSA / KRIVKA AR AR ARAR
THROUGH | BOD/VRCHOL v IV I|iv |V

ROVINA

VALEC v v Iiv I v | Vv

- v | vV

NORMAL |- HRANA/OSA/KRIVKA

ROVINA v I VIV I Vv |V
PARALLEL | RovINA v | v %
TANGENT | A gC AR

V tabulce neni zahrnuta podminka OFFSET (odsazeni), ktera je samostatnou podminkou, tj. neni nutna zadna jina
podminka k definovani nové roviny. TaktéZ volba THROUGH PLANE (skrz rovinu) je samostatnou podminkou a definuje
novou rovinu, kterd ovéem lezi na roviné referencni.

UKAZKOVY PRIKLAD VYTVORENI POMOCNE ROVINY

1.

>

2.

Kliknéte na ikonu % .
Nejprve uréime, Ze nova rovina bude rovnobé&Zna s rovinou pldorys.

Oznacte rovinu pldorys a v rozbalovaci nabidce vyberte Parallel (viz obr.)

NARYS

& DATUM PLANE X

Flacement | Display | Properties

Fieferences

FUDORYS:F2DATL. . §REEE]
Through
Offzet

Parallel

Cancel
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& Pred pridanim daléi podminky je nutné stisknout a drzet tlacitko CTRL, jinak nové podminka nahradi tu pGvodni.

> Nyni uré¢ime, Ze nova rovina bude tecna k valcové plose hridele.
3. Pridrzte CTRL a oznacte valcovou plochu a v rozbalovaci nabidce vyberte Tangent.

NARYS

B DATLUM PLANE

Placement | Dizplay || Prnpertiesl

References
PUDDRAYS:F2DATU... Parallel
SUFBIEXTRUDE 1] RN W

Tangent

Offzet
Trangzlation

BOKORYS

> Nyni pojmenujeme nové vytvarenou rovinu (nepovinné) a potvrdime vytvoreni roviny.
4. Zvolte zalozku Properties a prejmenuijte rovinu na HORNI.

5. Potvrdte vytvoreni roviny kliknutim na
ORNI

PUDORYS

BOKORYS

> Nyni Ize tuto pomocnou rovinu pouzit jako skicovaci rovinu a protazenim ovalného profilu vytvorit drazku pro pero.




POMOCNE OSY

Priklady pouziti pomocnych os:
o Jako reference pro vytvareni konstrukénich prvkl
e Jako reference pro vytvareni pomocnych rovin

.
\!) PFi vytvareni valcovitych soucasti a dér jsou pomocné osy vytvareny automaticky

VYTVARENI POMOCNE OSY

I
>  Kliknéte na ikonu ¢  nebo v menu Insert>Model datum->Axis...

> Objevi se dialogové okno Datum Axis.

B DATUM AXIS

Flacement | Display " Properties |

References > Na jednotlivych zaloZkach Ize nastavit:
¢ Placement - umisténi osy, vlastni definovani osy
o Display - velikost osy

Offset refererices + Properties - nazev osy

o[ Cancel |

> Jako reference mlzete vybrat nasledujici entity:
e Hrana (edge)
e Krivka (curve)
e Rovinna plocha
e Valcova plocha
e Systém souradnic (coordinate system)
e Bod, vrchol (point, vertex)

MOZNOSTI VYTVARENI POMOCNYCH 0OS

e Osa prochazejici skrz hranu

B DATUM AXIS

| Placement |Displa_l,l || F'ru:uperties|

References

Edoe:FE[EXTRUDE_1] Through

Offzet references




b

Osa kolma na rovinu

Presnou polohu osy je nutno dodefinovat pomoci dvou zelenych uchycovacich bodl. Kazdy z nich Ize uchytit
k hrang, ploSe, roviné nebo ose a nastavit vic¢i nim vzdalenost.

Placement

References

DATLIM AXIS

Dizplay || Properties |

SwkFBEXTRUDE_T]  Marmal

Offzet references

FUDORYS_:F20(DAT... 40.00

BOKORYS:F1[DATU...  F0.00

Osa kolma na rovinu prochazejici bodem - podobné predchazejicimu pfipadu, pouze poloha osy bude uréena bodem

B DATUM AXIS

Flacement

Dizplay " Froperties |

References

PHTOFTSDATUM P...
Surf:FEEXTRUDE_1]

Thraugh

Marrnal

Oftzet references

Osa prochazejici stfedem valcové plochy nebo stifedem zaobleni

B DATLM AXIS

Placement

Dizplay " Properties |

References

SuF18ROUND_1)

Through

(ffzet references




e Osa prochazejici skrz priseénici dvou rovin

DATUM AXIS

| Placement Dizplay " F'ru:uperties|

References

BOKORYS:F1DATU...  Through
DTM1LF10DATUM F... Through

Offzet references

e Osa prochazejici skrz dva body/vrcholy

XPNTOQ

Flacement | Dizplay " Froperties |

References

Wertew: Edoe:FRIEXTR... Through
PMTOFTISDATUM P, Through

Offzet references

e Osa te¢na ke kfivce a prochazejici vrcholem/bodem

DATUM AXIS

Flacement | Digplay || Properties |

References

Edge:F[CHAMFER_1] Tangent
PHTO:F10[DATURM P...  Through

Offzet references
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POMOCNE BODY

Priklady pouziti pomocnych bod(:
e Jako reference pro vytvareni pomocnych rovin a os
e Pri vytvareni soufadného systému
e Pro specifikaci bodového zatizeni pfi vytvareni sité (mesh)

VYTVARENI POMOCNYCH BODU

X
» Kliknéte na ikonu ** nebo v menu Insert>Model datum-=Point>Point...
> Objevi se dialogové okno Datum Point.

& DATUM POINT 3

Flacement | Froperties

Ref
[ | Foferences » Na zaloZkach Ize nastavit:

e Placement - umisténi bodu
e Properties - nazev bodu

Cancel

MOZNOSTI VYTVARENI POMOCNYCH BODU

e Bod lezici na plose/roviné

y Presnou polohu bodu je nutno dodefinovat pomoci dvou zelenych uchycovacich bod@. Kazdy z nich Ize uchytit
k hrané, plose, roviné nebo ose a nastavit vi¢i nim vzdalenost.

FUDORYS

B DATUM POINT

Flacement | Properties

% New Paint SultFEXTRUDE_1) On

Offzet references
PUDORYS:F2DATU... 31.63
BOKORYS:F1[DATU... 71.19




e Bod v zadané vzdalenosti od plochy/roviny PUDORYS

| DATUM POINT

Placemsnt | Properties |

% MNew Paint SufFSEXTRUDE_T)  Offset

Offzet | 30,00 »

Offzet references
PUDORYS:F2DATUM ... 60.00
BOKORYS:FIDATUM ... 80.00

e Bod v prisediku tfi povrchl

H DATUM POINT

‘ Placement | Properties |

—W References

% New Point SufFEEXTRUDE_T)  On

L ]
SurkF18[CHAMFER_1]  On
® Surf:FREXTRUDE_1) On
Mest Intersection
o
L ]

e Bod umistény na vrcholu hrany,plochy nebo kfivky

I & DATUM POINT

Placement | Properties |

# New Point Wertew Edge:FBIEXTRU... On

L
@
&
®
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e Bod ve stfedu oblouku ¢i zaobleného rohu

& DATUM POINT
‘ Placerment | Properties |
* —m References
# New Paint Edge:F12[HOLE_1] Center
¢ Bod umistény na hrané nebo kfivce
& DATUM POINT

» V kolonce offset Ize nastavit:

Po vybrani hrany nebo kfivky se zpfistupni dalsi ovladaci prvky v dialogu.

Placemant | Properties

. OE |

* New Point

References
Edge:F18[CHAMFER_1] On

ffiset |0.30 v|[Ratio |

Offzet reference

() End of curve
Ofeference ||

e Ratio - zadavate hodnotu v rozmezi 0-1 jako pomérovou vzdalenost od zvoleného konce hrany/kfivky
( 0=lezi na zvoleném konci, 1=lezi na opacném konci)

¢ Real - zadavate hodnotu v milimetrech od zvoleného konce hrany/kfivky

Tlacitkem vyberete druhy konec hrany/kfivky

Zaskrtnutim politka Reference Ize zvolit referenéni element, vici némuz urcujete vzdalenost




NASKICOVANY POMOCNY BOD

gt x -
>  Kliknéte na ikonu  (pod ikonou ** ") nebo v menu Insert>Model datum-Point->Sketched ...
> Objevi se dialogové okno Sketched Datum Point.

B Sketched Datum Point

Flacement | Properties |

Sketch Flane

Flane IJze Previous

Sketch Onentatian

30.00

Sketch view direction | Flip

Reference | |

Orientation

Sketch

» Vyberte skicovaci rovinu a prepnéte se do skicare kliknutim na tlacitko Sketch .

>  Umistéte bod pomoci ikony * a zakotujte.




4. PRIKAZ PROTAZENI (EXTRUDE)

UKAZKA

15.00

&3] Flacement  Options  Properties

i
Ola [&-Fn 8% 4 C N “eo [v] X

POPIS PRIKAZU

Vytvoii téleso nebo plochu pfidanim nebo odebranim materialu kolmym protaZenim skici vzhledem ke skicovaci roving.
Pomoci tohoto pfikazu je mozné vytvorit:

e Objemové téleso kolmym protazenim skici (uzaviené smycky)

e Vyfiznuti/odFiznuti otvoru/diry kolmym protazenim skici libovolného priifezu (uzavfené smyéky)

e Tenkosténné téleso kolmym protazenim skici (uzaviené i oteviené smycky)

e Rovinné plochy protazenim skici (uzaviené i oteviené smycky)
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SPUSTENI PRIKAZU

> PFikaz Extrude spustime nasledujicimi zplsoby:

i’ v .. v
e Ikonou v bocni nastrojové liste
eV nabidkové listé (menu): Insert->Extrude...

> Dale se ridte pokyny uvedenymi ve stavovém radku.

MENU PLACEMENT

UMISTENI SKICI (PLACEMENT)

» . PakliZze chcete vytvaret tenkosténny prvek nebo plochu, stisknéte nejdfive ikonu = pro tenkosténny prvek nebo =
1 pro plochu . Systém poté bude védét, ze chcete vytvaret tenkosténné téleso nebo plochu a nebude pozadovat
uzavienou smycku ve skicari.

> Tladitko | Plasement | jo Gervené oznadeno, co? signalizuje, Ze zatim nebyla definovana skica.
>  Po kliknuti na tlacitko Placement mame dvé volby:

e Definovat novou skicu kliknutim na tlacitko (interni skica).

e Zvolit pfedem pripravenou skicu (externi skica) tim, Ze ji vybereme ve stromé nebo v hlavnim grafickém okné.

DEFINICE NOVE SKICI

> Dialogové okno Sketch obsahuje nasledujici ovladaci prvky:
. - pouZije se posledni pouzita skicovaci a referencni rovina

. - obraci smér pohledu na skicovaci rovinu
¢ Plane - zadani skicovaci roviny (Ize pouzit pomocna rovina nebo rovinna plocha télesa)
¢ Reference - zadani referencniho prvku pro orientaci skici

e Orientation - (Right, Left, Top, Bottom) - urCuje, kde se referencni prvek na vykrese bude nachazet (vpravo,
vlevo, nahore, dole) - ¢imz Ize urcit orientace skici.

. - potvrzeni zadanych hodnot a vstup do skicae ® Sketch X
. - zruSeni provadéné definice skici Flacement

Sketch Plane
w Vice informaci o praci ve skicari se dozvite na strané ... Planes [ NARYSEIDAT
Sketch Orientation

Sketch view direction

Reference | BOKORYS:F1DATUM PLANE]

Crigntation | Right b

»  Chcete-li zménit vybranou skicovaci rovinu nebo referencni prvek, kliknéte na pole s ndazvem prvku (viz obr.), ktery chcete
zménit a vyberte jiny prvek v hlavnim okné nebo ve stromé.

B Sketch 3

Placement

Sketch Plane

Plane | BOKORYS:F

Sketch Orientation

Sketch view direction
FEEEC PLIDO
Orientation | Left hd




DIALOGOVA LISTA

» Uzivatelské rozhrani pfikazu Extrude tvori dialogova lista.

D’j Flacement  Options  Properties
(A2 |dE~[4815 | % C ]| X
g Select a sketch, (IF an internal sketch is prefarred, the "Define” option can be found in the Placement panel.) =

>  Popis ovladacich prvk{ nastrojové listy:

0 Vytvareni objemového télesa (solid)
] Vytvareni ploch (surface)
1k~ Ukonceni protazeni - rozmérem, plochou, kfivkou, rovinou, symetricky od skicovaci roviny, skrz vse...
BOO0 Hloubka protaZeni
“ Zmeéni smér protazeni prvku vzhledem ke skicovaci roviné (= kliknuti na zlutou Sipku v hlavnim okné)
] OdFiznuti prvku (Cut) protazenim
[ |343 ~|| Vytvoreni tenkosténného prvku, zadani tloustky tenkosténného prvku

Pozastaveni tvorby prvku (pfi pozastaveni mizete vytvaret naptiklad externi skicu)

Zobrazit nahled prvku

Potvrdit vytvoreni prvku protazeni

| |
X

Zrusit vytvareni prvku protazeni

MENU OPTIONS

> V tomto menu se nachazi volby urceni hloubky protazeni.
> MUzZete urcit protaZeni v obou smérech kolmych na skicovaci rovinu nezévisle na sobé.

Depth
Side1 | 4k Blind * | |50.00 A
Side 2 | 1L 7g Newt »

oLk Blind Protazeni o zadanou hodnotu od skicovaci roviny v daném sméru
-F3- Syrarmetric ProtaZeni o zadanou hodnotu od skicovaci roviny v obou smérech
== To Mext Protazeni v daném sméru az po dalsi plochu soucasti
3 | Through Al ProtaZeni otvoru skrz vée, vyuZitelné pfi aktivované ikoné 4| (odtezévani - Cut)
2 Through Untl | ProtaZeni az po zadany povrch
4k To Selected ProtaZeni az po zadany prvek (plocha, rovina, quilt)
Hare Dostupné pouze u druhého sméru(Side 2), v tomto sméru se protazeni neuskutecni




To Selected \  Through All

Through Until

To Next

Blind

Through All

To Selected

Through Until
To Next
DTM2
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UKAZKY TELES VYTVORENYCH POMOCI PROTAZENI

PROTAZENI OBJEMOVEHO TELESA

> Jak Ize vidét na obrazku, pomoci prvku protazeni mdZeme vytahnout skicu slouzenou z vice nez jedné uzavitené smycky.

40.00

| 10.00
@ PFiklad protaZeni objemového télesa najdete v 1.CVICENI - krok &.2

3 V 99% pripadd je nutné mit p¥i protazeni objemového télesa uzavienou smycku ve skice.

Existuji vSak i vyjimky, napfiklad pfi vytvareni zeber neni uzaviena smycka vyzadovana.

VYRIZNUTI OTVORU KOLMYM PROTAZENIM SKICI LIBOVOLNEHO PRUREZU

> Pomoci prvku protazeni miZzeme vyFiznout do télesa diru libovolného priifezu.

, i Diru kruhového priifezu je ¢asto vyhodné&jsi vytvoFit pomoci prvku A Hole, jelikoZ pomoci tohoto prvku Ize vytvorit
diru I se zahloubenim, se zavitem I s kuzelovym zakoncéenim.

@ PFiklad vyfiznuti objemového télesa najdete v 1.CVICENI - krok ¢&.3

45




PROTAZENI TENKOSTENNEHO TELESA

>  Pred vytvorenim vlastni skici je dlleZité aktivovat ikonu , ¢imz date systému najevo, ze budete vytvaret
tenkosténné téleso a systém tudiZz nebude ve skicafi vyzadovat zadani uzaviené smycky. Nasledné pak nastavit velikost
tloustky stény vytvareného télesa.

20.00

PROTAZENI PLOCH

> Pred vytvorenim skici je dlleZité aktivovat ikonu

&

, ¢imz date systému najevo, Ze budete vytvaret plochy a systém tudiz

nebude ve skicafi vyzadovat zadani uzaviené smycky.

46




5. PRIKAZ ROTACE (REVOLVE)

UKAZKA

Placement  Optionz  Properties

O]@® (i J[LE-m0_ ™% 4 C N viso [v] x

s

A
ﬁ@

POPIS PRIKAZU

Vytvoii téleso nebo plochu pfidanim nebo odebranim materialu rotaci skici kolem osy.
Pomoci tohoto pfikazu je mozné vytvorit:

e Objemové téleso rotaci skici(uzaviené smycky) kolem osy

e Vyfiznuti/odFiznuti otvoru/diry rotaci skici(uzaviené smycky) kolem osy

e Tenkosténné téleso rotaci skici (uzaviené i oteviené smycky) kolem osy

e Rotacni plochu pomoci rotace skici (uzaviené i oteviené smycky)
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SPUSTENI PRIKAZU

> Prikaz Revolve spustime nasledujicimi zplisoby:

e Ikonou Ry bocni nastrojové listé
eV nabidkové listé (menu): Insert->Revolve...
> Dale se ridte pokyny uvedenymi ve stavovém radku.

MENU PLACEMENT

UMISTENI SKICI (PLACEMENT)

o . PakliZe chcete vytvaret tenkosténny prvek nebo plochu, stisknéte nejdFive ikonu = pro tenkosténny prvek nebo
pro plochu . Systém poté bude védét, Ze chcete vytvaret tenkosténné téleso nebo plochu a nebude pozadovat
uzavienou smvcku ve skicafi.

> Cervené oznadené tladitko | Pacement | signalizuje, Ze zatim nebyla definovéana skica.
>  Po kliknuti na tlacitko Placement nejprve definujeme skicu, mizeme to udélat dvéma zplsoby:

e Definovat novou skicu kliknutim na tlacitko (interni skica).

o

e Zvolit pfedem pfipravenou skicu (externi skica) tim, Ze ji vybereme ve stromé nebo v hlavnim grafickém okné.

Sketch

® Select 1 item Defi[[ﬁ...

DEFINICE NOVE SKICI

> Dialogové okno Sketch obsahuje nasledujici ovladaci prvky:
. - pouZije se posledni pouzita skicovaci a referencni rovina

. - obraci smér pohledu na skicovaci rovinu
¢ Plane - zadani skicovaci roviny (Ize pouzit pomocna rovina nebo rovinna plocha télesa)
¢ Reference - zadani referenéniho prvku pro orientaci skici

e Orientation - (Right, Left, Top, Bottom) - urcuje, kde se referenc¢ni prvek na vykrese bude nachazet (vpravo,

vlevo, nahore, dole) - ¢imz Ize urcit orientace skici.
. - potvrzeni zadanych hodnot a vstup do skicare
. - zrudeni provadéné definice skici Placement
Sketch Plane
w Vice informaci o praci ve skicari se dozvite na strané ... Planes [ NARYSEIDAT
Sketch Orientation

Sketch view direction

Reference | BOKORYS:F1DATUM PLANE]

Crigntation | Right b




»  Chcete-li zménit vybranou skicovaci rovinu nebo referencni prvek, kliknéte na pole B Sketch E|
s nazvem prvku (viz obr.), ktery chcete zménit a vyberte jiny prvek v hlavnim okné '

M Flacement
nebo ve stromé.

Sketch Plane

Plane | BOKORYS:F

Sketch Onentation

Sketch wiew direction
Reference
Orientation | Left v
[sketch ] [ Cancel]

>  Po nadefinovani skici je potfeba jesté zvolit osu rotace. MiZete ji definovat t&mito zplsoby:
e Pouzijte pfeddefinované pomocné osy OSA_X, OSA_Y nebo OSA_Z

e Ve skicafi vytvorte osu skici i , kterd se pak automaticky pouZije jako osa rotace

I
e Nadefinujte pomocné osy pomoci ikony ¢ (ty Ize vytvofit i v pribéhu vytvareni prvku rotace pomoci pauzy I )

Sketch
Intemal 5§ 200005
Bl

Select 1 itern %

DIALOGOVA LISTA

Uzivatelské rozhrani pfikazu Revolve tvofi dialogova lista.

.;55-3::. Placement Optionz Properties

(3 (165 [ Select 1 item Ak~ [m000 v A4 i || X

>  Popis ovladacich prvk{ nastrojové listy:

[ Vytvareni objemového télesa (solid)
] Vytvareni ploch (surface)
(19 [ Select 1 item Vybér osy rotace
ik~ Uhel rotace dany - rozmérem, rozmérem-symetricky, k vybranému bodu,povrchu,roviné

/OO0 v Uhel rotace

A Zméni smér rotaceprvku vzhledem ke skicovaci roviné

OdFiznuti rotaci (Cut)

e ~| 4 | Vytvofeni tenkost&nného prvku, zadani tloudtky tenkost&nného prvku

Pozastaveni tvorby prvku (pFi pozastaveni mlzete vytvaret naptiklad externi skicu)

Zobrazit nahled prvku

]
Potvrdit vytvoreni prvku
X

Zrusit vytvareni prvku




MENU OPTIONS

» V tomto menu se nachazi volby Ghlu rotace.
> Mulzete zde uréit rotaci v obou smérech(danych skicovaci rovinou) nezavisle na sobé.

Angle

Sidel dbVaisble v |[18000 v

Side 2 | Ak ToSelected ¥ || PUDORYS:F2(

Capped Ends
Ak Variable Rotace o zadany uhel danym smérem od skicovaci roviny
-F3- Syrmetric Rotace o zadany Uhel symetricky na obé strany od skicovaci roviny
Lk ToSelected Rotace danym smérem aZ po zadany prvek (bod, plocha, rovina)
More Dostupné pouze u druhého sméru(Side 2), v tomto sméru se rotace neuskutecni

UKAZKY TELES VYTVORENYCH POMOCI ROTACE

ROTACE OBJEMOVEHO TELESA

» Pomoci rotace lIze vytvofit objemové téleso zadanim uzaviené smycky a osy rotace.

|
i 320.00
|
: 200.00 '
|
= 70.00 ——= l—— 70,00 —=
H
H v H | H
T P AYS .ﬁ
v Yo 40,00
B 50.00 — 60.00 50.00 40,




VYRIZNUTI ROTACI SKICI KOLEM OSY

> Jak Ize vidét na obrazku, pomoci prvku rotace Ize do obémového télesa vyfiznout otvor.

= 65.00 =

|
115.00 ’—a— 50.00 —= ~ 200
J

@ PFiklad protaZzeni objemového télesa najdete v 1.CVICENT - krok ¢.2

ROTACE PLOCH

>  Pred vytvorenim skici je dlleZité aktivovat ikonu H pro vytvareni ploch nebo L pro vytvareni tenkosténnych téles, ¢imz
date systému najevo, ze nemusi vyzadovat zadani uzaviené smycky.

| 20.00

e 100.00 100.00
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6. RESENi ZHAVAROVANYCH PRVKU (FAILURE RESOLUTION)

uvobp

>  Konstrukce prvkl miZe b&hem modelovani zhavarovat, stava se tak pfi vytvaFeni, modifikaci a predefinovani prvku.

> Zhavarovani prvkll se mize projevit bud ihned nebo aZ pfi nasledujici regeneraci. Re$eni havarii vzniklych pfi regeneraci
nebyva tak zifejmé jako je tomu pfi havarii vzniklé pfi vytvareni prvku.

>  Zakladem k Uspésnému vyreSeni havarie vzniklé pfi regeneraci prvku je obeznameni se s prostfedim zvanym
Resolve Environment, které je uzplisobeno k fedeni havarii.

> Prostfedi Resolve Environment se vyznacuje:
e Zobrazi se okno Failure Diagnostics s popisem pricin zhavarovani a Menu Manager s volbami pro napravu.
e Zhavarovany prvek zlstane nezregerovan, zobrazi se pouze ty prvky, u kterych Gsp&$né probé&hla regenerace.
o Znatka P InsertHere se ve stromé zobrazi piimo nad zhavarovanym prvkem.
o Vétsina standardnich pfikaz{ a ikon je nedostupnd, v tomto prostiedi pouzivejte k praci Menu Manager.

B Failure Diagnostics

Menu Manager

File Edit ‘Wiew

. w RESCOLVE FEAT
IClick for:

< Dverview > £ Feature Info > Undo Changes

IFEATURE #9 (DATUM AXIS), PART PRTOO82, failed regeneration. Ineestigate

- Could not place feature to create it. Fix Model

- Feature references are missing. Quick Fix
¢ 5 Done/Return

MOZNOSTI RESENI HAVARII V PROSTREDI RESOLVE ENVIRONMENT

» Model mize zhavarovat ze spousty dGvod( (potlaeni & smazéni rodi¢ovského prvku, geometrii nelze vytvorit, problémy
s referencemi, apod.)

» Zhavarovany prvek mize byt prvek, ktery jsme pravé modifikovali nebo to miZe byt prvek na ném zavisly (potomek).

> Pokud dojde k havarii nékterého prvku, systém Pro/ENGINEER se prepne do prostfedi Resolve Environment a neumozni
nam pokracovat, dokud danou havarii nevyresime.

Menu Manager

> Menu Manager obsahuje nasledujici nabidky:

¢ Undo Changes - vratit posledni zménu zpét a tim vratit model do stavu pied havarii w RESOLVE FEAT

+ Investigate - vysetifeni havarie, moznost otevieni IUIndo Changes

¢ Fix Model - Uprava modelu Investigate

¢ Quick Fix - obsahuje nejdtilezité&jsi pFikazy pro opravu zhavarovaného modelu Fix: Model
Cuick, Fix
Done,/Return

. Fix Model nebo Quick Fix? Nabidka Fix Model umozriuje manipulaci se vSéemi prvky, které predchazeji havarovany
1 prvek i s prvkem samotnym a pouziva se, kdyZ je nutné upravovat vice prvkd. Oproti tomu nabidka Quick Fix umozZfiuje
rychlou a efektivni Upravu havarovaného prvku a pouziva se, paklize staci upravit pouze zhavarovany prvek.

Tlac¢itko Undo Changes funguje pouze omezené a prestane byt aktivni po nékterych pokusech o napravu havarie. Proto
se doporucuje, pokud nemate vytvorenou zalohu, vyuzit tohoto tlacitka k vraceni se zpét a vytvoreni zalohy modelu.




ZRUSENI ZMEN (UNDO CHANGES)

» Tato volba umoznuje zrusit modifikace, které vedly k havarii prvku. Menu Manager
> Tato volba tedy neresi problém havarie, ale ma nasledujici vyuziti:
¢ Umoznuje uzivateli pfedejit havarii provedenim modifikace nezhavarovaného modelu. Inwestigats

¢ Umoznuje uzivateli navrat k nezhavarovanému modelu a provedeni zalohy. Fiz Madel
¢ Umoznuje uzivateli vyhnout se uzivatelskému prostfedi Resolve Environment a Menu Manageru. Quick. iz
e UmoZAuje pristup ke vdem standardnim pFikazdm, které nejsou dostupné v Resolve Environment. Done/Return

ZJISTENI PRICIN HAVARIE (INVESTIGATE)

> Toto menu obsahuje nastroje pro zjisténi pric¢in havarie.

e Current Modl - prepnuti na aktualni zhavarovany model

¢ Backup Modl - po zvoleni této volby budete vyzvani k otevieni souboru s modelem pred havarii,
po zvoleni tohoto modelu se miZete prepinat mezi aktuainim a zaloZznim modelem

¢ Diagnostics - zobrazi/vypne okno Failure Diagnostics

o List Changes - zobrazi seznam kot a parametrl, které byly zménény (Information Window)
o Show Ref - zobrazi okno Reference Viewer, potomky a déti zhavarovaného prvku.

¢ Failed Ref - umoZnuje zobrazit neplatnou geometrii (neni dostupné vzdy)

¢ Roll Model - pracuje s Backup Modl (viz dale)

Menu Manager

Investigate
Fiz Model
Quick. Fix

Done,/Return

INYESTIGATE

Current Madl

Backup Maodl | Reference Viewer
Diagniostics File iew Actions
List Changes Reference Filters | Pathe Current Object: ;‘ B4 1in PRTO00ZPRT
Shaw Ref Show: @ References Mew Patry| # BA_1in PRTO00..
() Dependencies
£7 DTH1
Rall Madel Scope All ¥
Status Al v
StrongAveak | Al w
Reference Types:
Regul
B INFORMATION. WINDOW. (moditems.inf) R @A_1 in PRTO00Z.
Placement i PRT
File Edit Wiew . ¥
] Relation 7 Edtruds 1 ()—— —+ & (%
The following model parameters are.mul:liFied. ] Sustem T Edrude 2
IParameter Value Previous Ualue e Bl
omponents In pal
C_HMOTHDST 9.598 11.321 E ;
bendent Children
ded Children
< ¥
rezzed Children
- el Tree
Fiter By | Perent or Child References (8 Parents X| Current Object Children x

ROLL MODEL
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>  Pokud jste zvolili Backup Modl a zadali ze souboru nezhavarovany uloZeny model, miZe se vdm hodit toto menu.
> Nastavte nezhavarovany model jako aktivni kliknutim na Backup Modl.
> Nyni miZete vyuZivat nasledujici volby:

w ROLL MOL T
Failed Feat zhavarovaném prvku

o Failed Feat - nastavi zalozni model do stavu, kdy systém potlaci vSechny prvky po

« Before Fail - nastavi zalozni model do stavu, kdy systém potlaci vsechny prvky pocinaje
zhavarovanym prvkem

e Last Success - systém vrati model do stavu posledni Uspésné regenerace
e Specify - vyberte prvek, ktery mé byt poslednim zobrazenym prvkem modelu

Before Fail
Last Success
Specify

Done/Return

UPRAVA MODELU (FIX MODEL)

>V tomto menu mdZeme upravovat véechny prvky, které predchazeji havarovany prvek i s prvkem samotnym.

e Pomoci polozek Current Modl se mizeme pFepnout do zhavarovaného modelu.
e Pomoci polozky Backup Modl se miiZzeme prepnout do zalozniho modelu.

Current Maodl

Backup Mod|

Feature e Feauture - kopirovani,mazani, potlaceni, redefinovani, znasobeni, zrcadleni apod.
Modify ¢ Modify - modifikovani két, pomocné geometrie atd.

Reqgenetate ¢ Regenerate - spusti regeneraci modelu

Switch i e Switch Dim - prepnuti zobrazeni két mezi hodnotami kot a jejich nazvy

Restare e Restore - umozfiuje obnovit hodnoty két, parametrl a relaci do stavu pred havarii
Relations e Relations - Uprava relaci modelu

OPRAVA ZHAVAROVANEHO PRVKU (QUICK FIX)

> Toto menu obsahuje nejdlleZit&jsi prikazy pro opravu zhavarovaného modelu.

Redefine

Reroute

Suppress
Clip Supp
Deleke

REDEFINE

> Je to stejny prikaz jako Edit Definition (ktery je bézné dostupny v kontextovém menu kliknutim pravym tl. ve stromé).
> Umoziuje predefinovat zhavarovany prvek.

w Vice informaci o pfikazu Edit Definition se dozvite v HISTORIE na str.3

REROUTE

> Je to stejny prikaz jako Edit References (ktery je bézné dostupny v kontextovém menu kliknutim pravym tl. ve stromé).
> Umoznuje zaménit problematické reference zhavarovaného prvku.

w Vice informaci o pfikazu Edit References se dozvite v HISTORIE na str.3-6

SUPPRESS

>  Potlaceni zhavarovaného prvku, systém nabidne dalsi menu:

w TRIM CHILD

Suppress All - potlaci vSechny déti spolu s havarovanym prvkem

Suppress Al o
Suspend Al Suspend All - potlaci zhavarovany prvek a ponecha jeho potomky (vede k dalSim havariim potomku)
Rerouts Al Reroute All - potladi zhavarovany prvek a nabidne pfesmérovani potomkd

Quit Quit - navrat do predchoziho menu

w Nazornou ukazku funkce Suppress naleznete ve 3.cvieni na str.14, dalsi informace v HISTORIE na str.3
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CLIP SUPP - potlaceni zhavarovaného prvku a vSech prvk{ ve stromé pod nim.

DELETE

» Smazani zhavarovaného prvku, systém nabidne dalsi menu:

w TRIM CHILD

Delete All - smaze vSechny déti spolu s havarovanym prvkem

Delete All o
s - Suspend All - smaze zhavarovany prvek a ponecha jeho potomky (vede k dalSim havariim potomku)
Lspen
N F e Reroute All - smaZe zhavarovany prvek a nabidne pfesmérovani potomk{
eroute , v ’
Quit Quit - navrat do predchoziho menu
L

w Dalsi informace funkce DELETE naleznete v HISTORIE na str.2
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7. ZNASOBENI PRVKU (PATTERN)

UKAZKA

>  Znasobeni jsou jedno nebo dvourozmérova pole prvki vytvorenych z jednoho prvku zvaného vedouci prvek (leader).
> Kdyz je znasobeni vytvoreno, stava se vedouci prvek soucasti znasobeni - prvnim prvkem znasobeni.

&

& &
§ & &
§ & 8
—

> Zde je nazorna ukazka Uspory prace, kterou prvek znasobeni nabizi. Protiskluzové vroubkovani zobrazené na obrazcich nize
by Slo vytvofrit jen velice pracné bez pouziti prvku pattern.
>  (Znasobeni na téchto obrazcich je vytvoreno dvéma prvky pattern

* . Znasobeni na téchto obrazcich je vytvoreno dvéma prvky pattern s nastavenim: FILL (vyplInit) a TRIANGLE
8 | (trojuhelnikovy vzor)

VYHODY POUZITI PRVKU ZNASOBENI

> Znasobeni je uziteCny prvek v objemovém modelovani, jelikoz urychluje vytvareni modelu.

e Prvek znasobeni vytvari mnozstvi zadané mnozstvi kopii vedouciho prvku a tim Setfi Cas.

e VsSechny instance prvku véetné vedouciho prvku se chovaji jako jediny prvek a tak mohou byt jednoduse potlaceny,
ozrcadleny apod.

e VsSechny instance v prvku zndsobeni jsou parametricky zakotovany. Je mozné snadno ménit pocet instanci prvku,
vzdalenost mezi sousednimi prvky a dal$i parametry.

o Jestlize se zmé&ni rozméry vedouciho prvku, zméni se i rozmé&ry viech jeho potomk{ (ostatnich prvkl znasoben).

7-1



DRUHY ZNASOBENI

o Dimension - prvek znasobeni je ovladan pomoci existujicich kot, které slouZi pro uréeni prirlistkovych rozmérd
e Direction - prvek znasobeni je fizen zadanym smérem

e AXxis - prvky tvofi kruhové znasobeni, pfiemz se vybira osa a Uhel mezi pvky

e Fill - prvek je fizeny zadanim pole, které ma byt vyplnéno instancemi, typem mfizky a vzdalenosti mezi prvky
e Table- pouzitim fidici tabulky (pattern table) a zad&nim fidicich rozmérd pro kazdou instanci

 Reference - prvek znasobeni je fizen odkazem na jiny znasobeny prvek

e Curve - umisténi jednotlivych instanci na kfivce naskicované ve skice.

SPUSTENI PRVKU ZNASOBENI

>  Prvek Znésobeni spustite jednim ze zpGsobu:

e Vybranim vedouciho prvku a kliknutim na ikonu =
e Kliknutim pravym tlacitkem na vedouci prvek a z kontextové nabidky vybranim Pattern...
> Zobrazi se dialogova lista prikazu Pattern

j Dimensgians Optiohs  Properties
Dimenzion w1 Select items 2 Click here to add item ]| m X
= —
Direction
Az
Fill b

SMAZANI PRVKU ZNASOBENI

> Prvek Znasobeni smazete vybranim tohoto prvku ve stromé, kliknutim pravym tlacitkem vyvolate kontextové menu, ve
kterém zvolte Delete Pattern.

> Timto postupem smaZete prvek Znésobeni, ale zachovate plvodni vedouci prvek narozdil od ptikazu Delete.

ZNASOBENI DLE KOT (DIMENSION PATTERN)

> V dialogové listé vyberte Dimension.
> V dialogové listé je zluté oznacené policko, systém nas vyzve k vybrani prvni koty.

j Dimenzions Optionz  Properties

Dimension | 1 Select iters 2 Click here ta add item | | b 4

e

2 Select dimensions ko vary in the first direction, e

>  Vyberte kétu, kterd bude uréovat relativni vzdalenost jednotlivych prvkd v 1.sméru.
> Zadejte relativni vzdalenost jednotlivych prvk{ (viz obr.)

\l/ V kazdém sméru Ize zadat i vice kot, které upravuiji tvar i polohu znasobenych prvk( v daném sméru.
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>V dialogové lit& zadejte polet prvkl v tomto sméru zadaném pravé vybranou kétou (viz obr. vlevo)
> Tyto prvky se v modelu zobrazi pomoci ¢ernych tecek (viz obr. vpravo)

Dimenzion % '| 1 iterm(s)

> TentyZ postup Ize zopakovat i v druhém sméru, paklize chceme dvourozmé&rné pole prvka.

> V dialogové listé pod nabidkou Dimensions Ize vybrané kdty a nastavené relativni

vzdalenosti upravovat a odebirat.

Drirection 1

Dimenszian [nzrement

d52F10(ExT... 4000

> Je také mozné zaskrtnutim policka Define increment by relation nastavit

relativni vzdalenost prvk{ pomoci relaci.

w Vice informaci o relacich se dozvite...

%

Define increment by relation
Drirection 2
Dirmengian [nizrement

d52F10(EXT... 4000

Define increment by relation
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ZNASOBENI DLE SMERU (DIRECTION PATTERN)

» V dialogové listé vyberte Direction.
> V dialogové listé je zluté oznacené policko, systém nas vyzve k vybrani prvniho sméru.

j Dimenzions Options  Properties

Direction &G 1| Select1it 2| Click here

g Select a Plane, Flat Face, Linear Curve, Csys or axis ko define the First direction,

» Vyberte rovinu, plochu, osu nebo soufadny systém
>  Zadejte relativni vzdalenost jednotlivych prvk{ (viz obr.)

>V dialogové li$té zadejte pocet prvkd ve vybraném sméru (viz horni obrazek)
» Tyto prvky se v modelu zobrazi pomoci ¢ernych tecek (viz dolni obrazek)

Ditection »| | 1| 1Edge Val: 20,00
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> Tenty? postup Ize zopakovat i v druhém sméru, paklize chceme dvourozmé&rné pole prvkd.

ZNASOBENI KOLEM OSY (AXIS PATTERN)

> V dialogové listé vyberte Axis.
> V dialogové listé je zluté oznacené policko, systém nas vyzve k vybrani osy.

j Dimengsions
iz 1| ® Select 1 item

g Select a Daktum Axis to define the pattern center,

> Vyberte osu a v dialogové listé zadejte pocet prvkl a Ghel mezi dvéma sousednimi prvky (viz horni obrazek)
» Tyto prvky se v modelu zobrazi pomoci ¢ernych tecek (viz dolni obrazek)

Az v 1] Titemls) “ s E0.00 v




> Lze také zadat pocet prvki{ ve smé&ru kolmém na rotaci (viz obr.)

dwis v 1] Tiem] 4 |8 BILOD v | A 2/3 15.00 v]

> V menu Options vénujte pozornost Member orientation on rotation plane, které uréuje natoceni prvki:
e Follow rotation - prvky se kolem osy nataceji. (viz obr. vlevo)
e Constant - prvky maji stejnou orientaci jako vedouci prvek. (viz obr. vpravo)

Follow rotation Constant
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ZNASOBENI ZADANIM POLE (FILL PATTERN)

» V dialogové listé vyberte Fill.
> V dialogové listé je zluté oznacené policko, systém nas vyzve k vybrani skici pro definovani hranic pole.

j Fiefere

Fill W | e Select 1 item

gy Select a sketch, (IF an internal sketch is pre

>  Skicu dopredu pfipravenou nemame, takze pouzijeme tlacitko n Pause, které prerusi vytvareni prvku znasobeni,
abychom mohli vytvorit pomocnou skicu.

» Pomocnou skicu vytvorime kliknutim na 24 a jako skicovaci plochu vybereme predni plochu télesa.

» Pomoci tlacitka o Use promitneme hrany télesa do skici a ukoncime tvorbu skici v

&

:I Fieferences Optiohs ~ Properties

I | | Sketch °2§2° Square v | L2188 w ’—\DDD - éD.DD - :}"\I ]| x

»  Skicu mame automaticky vybranou, nyni zbyva nastavit zbylé prarametry:
°2§i° Square "

- typ mrizky pole (viz obrazky nize)

siie[12.98 ¥ - vzdalenost mezi dvéma sousednimi prvky

o Ll 0.00 - minimaln{ vzdalenost stfedu kazdého prvku od okraje pole (brani pfesahu prvki pres okraj pole)
. ék 0.00 ¥ - rotace od pocatku
. oo ¥ - radiaini vzdalenost mezi prvky u kruhové a spiralové mfizky
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ZNASOBENI PODLE TABULKY (TABLE PATTERN)

» V dialogové listé vyberte Table.
» V dialogové listé je Zluté oznacené policko, systém nas vyziva k vybrani két, které budou Fizeny tabulkou.

j T able Dimensions Options  Properties

£ Select tems Active table TABLET b II x

g2 Select dimensions ko add to the pattern table, e

> Podrzime CTRL a vybereme kéty, které bude Fidit tabulka.
OSA_Z

|

OSA_X

y Aby znasobeni podle tabulky fungovalo zamyslenym zplsobem, je tfeba promyslet a upravit kdty i geometrické vazby.

> V menu Tables v dialogové liét& Ize upravovat tabulky, naéitat je ze souborl, mazat, ukladat atd.
> Tyto volby zobrazite kliknutim pravym tlacitkem do zluté oblasti a vybérem z kontextového menu.

[ndex M ame
TABLE1

£ *

T ablez

> V menu Table Dimensions v dialogové listé Ize mazat vybrané kéty (pravym tlacitkem a vybérem z menu).

dP3F10[EXTRLU...
dal:F10[EXTRL...
dra:F10[E=TRLU...

T able Dimensions
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> Nyni je nutné vyplnit tabulku, v dialogové listé kliknéte na tlacitko .

» V horni ¢asti tabulky jsou instrukce pro jeji vyplnéni:
e Indexy jednotlivych instanci zacinaji od 1, kazdy musi byt unikatni, ale ne nezbytné po sobé jdouci (1,3,4,8,15 apod.)
e Pouzijte [*] pro hodnotu koty stejnou jako u vedouciho prvku (hodnoty kot vedouciho prvku viz ¢erveny ramecek)

>  Vyplnéna Cast tabulky je oznacena modrym rameckem, kazdy radek tedy obsahuje Cislo instance prvku a tfi hodnoty kot.

C1 C2 C3 C4 C5 CE C7
F1 | -
Rz | Input placement dimensions and model name for each pattern member.
F3 | The model name is that of the pattern leader or any of itz family table instances.
R4 | Indices start from 1. Each index hasz to be unique,
RS | butnot neceszarly sequential.
RE | Usze ™ for default value equal ta the leader dimenzion and madel narme.
RY | Rows beginning with '@ will be saved as comments.
Fs |
F3 1 Table name TABLET.
F10 |
F11 ﬁ id= d73(30.00] d30(50.00) d473(50.00] ]
R1z2 1 10000 ¢ 180.00
R13 { 2 - 100.00 45.00
F14 3 100.00 10000 ¢
v
R15 ¢ >

> Uzavieme tabulku uzavienim okna s tabulkou, zadané hodnoty se automaticky ulozi
> V modelu jsou vidét tecky na pozicich instanci prvku Znasobeni.

> Potvrdime vytvoreni prvku Znasobeni
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ZNASOBENI DLE ODKAZU NA JINY PRVEK ZNASOBENI (REFERENCE PATTERN)

» Znasobeni se vytvori odkazem na jiny prvek znasobeni
Pocet prvki je vZdy stejny jako u odkazovaného prvku znasobeni, nelze Fidit.

> Vedouci prvek Znasobeni musi byt referencné zavazben k vedoucimu prvku odkazovaného Znasobeni.
Na obrazcich je vidét, Ze novy vedouci prvek mé stfed na stejné ose, jako plvodni vedouci prvek (soustfedné kruznice).

A\

OSA_Z

OSANY ] OSA_

»  Pri oznaceni nového prvku a spusténi prikazu Pattern ( 8| ) se v dialogové listé jako prednastavena objevi moZnost
Reference a vsechny ostatni volby(kromé zmény nazvu prvku v Properties) nejsou dostupné.

>  Staci pouze potvrdit provedeni pFikazu .

\l') Pokud nechcete vytvofit referenéni znasobeni, staci vybrat jiny typ znasobeni a vSechny volby budou opét dostupné.




8. RELACE A PARAMETRY

RELACE

> Relace poskytuji nastroj, kterym Ize do modelu zachytit konstrukéni zdmé&r. Vznikaji vytvarenim matematickych vztahQ
mezi jednotlivymi kdtami, parametry nebo prvky.

UZIVATELSKE ROZHRANI

>  Pro vytvéreni relaci je k dispozici rozhrani Relations, ke kterému se dostanete v menu Tools ->Relations...

B Relations

File Edit Insert Parameters Utilities  Show
Look In

11 Part w CINUZ -

2> a0 By R X 8F =2 1 @ fx o () Y D [

+l

o

£

I nitial A

p Local Parameters

> DdlleZité &asti dialogu Relations:
(1) - urcuje umisténi relaci (na Urovni prvku, soucasti, sestavy a dalsi..)
(2) - nastrojova nabidka s velmi uzitecnymi funkcemi:

. 3 urcuje, zda jsou v modelu zobrazeny hodnoty két nebo jejich nazvy
. =7 urci hodnotu kéty, parametru nebo vyrazu, funguje i jako kalkulacka
- I napisete nazev kéty a ona se zobrazi v modelu

] o vlozi funkci ze seznamu (abs, sin, cos atd.)

. 0. vloZi parametr

. = sefadi relace tak, aby nejprve probéhly relace, jejichz vysledky jsou
potfebné pro vypocet dalSich relaci (ty systém preradi nize)

. - zkontroluje spravnost zadanych relaci a parametr{
(3) - znaménka, zavorky pro urychleni prace

(4) - ptistup k parametriim

\l) Zobrazit nazvy két miZete kdykoliv pomoci pFikazu Switch Dimensions v menu Info.
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VYTVARENI RELACI

» Postup vytvareni relaci:
1. Otevrete dialog Relations (v menu Tools > Relations)
2. Zadejte nazvy két do otevieného dialogu
e pii otevieném dialogu Relations kliknéte na zadany prvek a zobrazi se koty

e pomoci prikazu i" Switch Dimensions Zjistite nazvy kot
3. Zadejte relace

TYPY RELACI

>  Existuji dva zakladni typy relaci:
e ROVNOST
e SROVNANI

ROVNOST

>  Priradi proménné na levé strané rovnice hodnotu vyrazu na pravé strané. Nejedna se tedy rovnici,ale pfifazeni hodnoty.
>  Priklady pouziti:

e d2=55 /* primé pfifazeni hodnoty 55 koté d2
o d4=d3/2 /* kété d4 je prifazena polovina hodnoty koty d3
e DELKA_SR=d32+5 /* ulozeni hodnoty d32+5 do parametru DELKA_SR
e d40=DELKA_SR /* pfifazeni hodnoty parametru DELKA_SR koété d40
SROVNAN{
» Porovnava vyraz na levé strané rovnice s vyrazem na pravé strané.
>  Priklad podminky:
e IFd3>20
d5= 25
ELSE
d5= 20
ENDIF
>  Prikaz IF zna¢i podminku. Podminka je vyraz, ktery miZe nabyvat hodnoty TRUE(PRAVDA) nebo FALSE(NEPRAVDA).
> Na dalsi fadek se zapiSe relace, ktera se provede pouze pfi splnéni podminky.
> Pod prikaz ELSE se zapiSe relace, ktera se provede pouze pfi nesplnéni podminky.
> Prikaz ENDIF se pouziva pro oznaceni konce srovnavaciho bloku.

; ' Rovnost se v podmince vyjadfuje jako == (protoze jednoduché rovnitko = se pouziva pro pfifazeni)
AP

\l/ Pfikaz ELSE musi byt zapsan na samostatném radku.




PARAMETRY

» Parametry umoznuji jednoduse definovat rozméry modelu bez nutnosti prepisovat koty modelu nebo upravovat relace.

A\

Parametry se obvykle pouZivaji v relacich, kde jsou provazany s kétami modelu a lze pomoci nich Fidit model.

> S vyhodou se daji parametry pouZit také pro prenaseni informaci z modelu do razitka vykresu. Razitko poté neni nutno
ru¢né vypliiovat a Ize tim predejit mnohym problémdm (protoZe informace modelu a ve vykresu budou identické).

UZIVATELSKE ROZHRANI

»  Pro spravu parametrl je k dispozici rozhrani Parameters, ke kterému se dostanete v menu Tools >Parameters...

B Parameters

EBX

Fil= Edit Parameters Tools Show
Lok In
1|[|F'art v||[:|NUZ w
Filter By | All v |
MHame Type Walue Dezignate | Access Saource Dezcription. Restricte
ALUTOR String bladejovaky @rﬁnFull User-Defi...‘
MATERIAL Sting 11500 aﬁ-Full oo UserDefi..
ROZMER  String 120450 %-Full o UserDefi..
NAZEY  Shing NUZ %-Full o UserDefi..
CISLO_Y.. Shing 755.005.001 %-Full v UserDefi..
2] C_ HMOT.. RealMu.. 72635000 O @Llocke. pejggion 4
T_ODP  Shing iy} @,j"Full - UserDefi..
TRIDEMI  Sing @,j"Full - UserDefi..
MAT WY, Shing 11800 ‘%‘iFull - UserDefi..
FOZICE  Integer 1 O @@Full - UserDefi..
< | >
3 g t] |Main w |[ Properties. .. ]@
Ok, Reset Caticel

> Dullezité ¢asti dialogu Parameters:
(1) - uréuje umisténi parametrt (na urovni prvku, soudasti, sestavy a dalsi..)

(2) - seznam parametrl a jejich vlastnosti (sloupce Ize ménit tlacitkem )

(3) - tlacitka pro pfidani/odebrani parametru

VYTVORENI PARAMETRU

> Pomoci tlacitka a naslednym zadanim vlastnosti parametru.

> Dostupné typy parametru:

¢ Integer - celé Cislo

¢ Real Number - realné cislo

e String - textova proménna

e Yes No - parametr typu boolean (ano/ne)
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EDITACE PARAMETRU

>  Editovat parametr miZeme bud’ pfimo v dialogovém okné Parameters nebo po kliknuti na [ IItE s ol EI
tlacitko _P“:'pe“ies-" v okné Parameter Properties.

> V okné Parameter Properties Ize nastavit napriklad jednotky parametru, jeho hodnotu, Nae
nazev, popisek a dalsi... DELKA,

> Jestlize je parametr pouzivany (napfiklad zadany v nékteré relaci) nelze pak ménit jeho e

nazev a datovy typ (popf. ani hodnotu, paklize je jeho hodnota dana vyrazem v relaci) Freal Tiumber 3

Walue
0.000000

Units

Optionz
[] Designated

Access

Ialﬁ\FuII v

Source
Uszer-Defined

Diezcription

Ok ] [ Cancel ]

SMAZANi PARAMETRU

> Pomoci tlacitka E Ize smazat parametr pouze pokud neni pouzivany (napf. v relacich).

> Jestlize je parametr pouzivany, lze zjistit, kterou kétu tento parametr fidi, popf. ¢im je Fizen:
¢ v okné Parameters kliknéte pravym tlacitkem na dany parametr
e pod polozkou Info se skryvaji volby Driven By...(je fizen) a Driving...(fidi)
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9. SAMOSTATNA PRACE - SKICOVANI

ProcviCit si skicovani - zaklady tvorby komponentd v systému PRO/ENGINEER na ukazkovych skicach .

v' znalost zakladd systému popsanych v tutorialu UVOD
v’ Protazeni (Extrude)
v Rotace (Revolve)

v' Skicar (Sketcher)
A Skici vytvarejte presné dle ukazky se stejnymi kétami , vazbami a rozméry.
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Krok c.9 Wytvorit novou soucast rotaci nasledujiciho profilu (Revolve)
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Krok ¢.10

Vytvorit novou soucdst rotaci nasledujiciho profilu (Revolve)
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Krok c.12 Wytvorit novou soucast rotaci nasledujiciho profilu (Revolve)
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Krok c.13

Vytvorit novou soucdst rotaci nasledujiciho profilu (Revolve)
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10. SAMOSTATNA PRACE - ZAOBLOVANI

CiL

Procvicit si rlizné typy a moznosti zaoblovani - zaklady tvorby radiusl v systému PRO/ENGINEER na ukazkovém modelu .

File Edt View Insent Analysis info Applications Tools Window Help : :
[bzosauveibamrndlDrecans touleaalo)assni]e

aolik|asa%i]ef

rnFlaresanszadiess b lasins

PREDPOKLADY

v znalost zaklad{ systému popsanych v tutorialu UVOD

v Protazeni (Extrude)

PROBIRANE PRVKY, FUNKCE A POSTUPY

v/ Radiusy (Round)

Je nutné pro fungovani ukazkovych radiust pouzivat nastaveni a skici presné dle
ukazky se stejnymi kétami , vazbami , rozméry a volbami.
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Krok ¢.3

Vytvorit radius vybranim dvou ploch a nastavenim jeho typu (D1 x D2 Conic) a velikosti - parametrd (Round)

File Edit View Insert Analysis Info Applications Tools Window Help
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Surf:FS(EXTRUDE_1)
Surf:F5(EXTRUDE_1)

10-6




25.0

10-7




File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.6 Wytvorit radius (Round) vybranim hrany a nastavenim jeho velikosti volbou kfivky (Through curve)

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c¢.7a Ndsledné omezeni jeho délky posunutim prvniho koncového bodu po zvoleni prislusného segmentu (Piece 1) z jejich nabidky (Pieces)

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.7b Ndsledné omezeni jeho délky posunutim druhého koncového bodu po zvoleni prislusného segmentu (Piece 1) z jejich nabidky (Pieces)

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.8a Wytvorit radius vybrénim hrany a nastavenim jeho velikosti (Round) - v ramci skupiny 1 (Set 1) a zaroveri

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.8b

Vytvorit dalsi radius vybranim druhé hrany a nastavenim jeho velikosti (Round) - v ramci skupiny 2 (Set 2) a zaroveri

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.8c Wytvorit dalsi radius vybranim treti hrany a nastavenim jeho velikosti (Round) - v ramci skupiny 3 (Set 3) a zaroveri

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.8d Nastaveni typu (volbou ikonky s rdzkem - druha z leva) prechodu mezi jednotlivymi radiusy (Translation) - nasleduji ukazky jednotlivych typd

File Edit View Insert Analysis Info Applications Tools Window Help
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File Edit View Insert Analysis Info Applications Tools Window Help
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File Edit View Insert Analysis Info Appli Tools Window Help
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Krok c.9 Vytvorit radius vybranim hrany a nastavenim jeho velikosti (Round) - proménné - v obou koncovych bodech ridzna
(Add - nabidka pod pravym tlacitkem mysi v oblasti doini tabulky)

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.10a Zaobleni vsech hran - vnitrnich i vnéjsich s mozZnosti nastaveni ridznych velikosti pro vnitrni' a vnéjsi radius pomoci funkce - Auto Round (nabidka Insert)

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.10b Vysledna podoba télesa

File Edit View Insert Analysis Info Applications Tools Window Help
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11. SAMOSTATNA PRACE-DIRY

ProcviCit si rlizné typy a mozZnosti tvorby dér - zaklady tvorby dér v systému PRO/ENGINEER na ukazkovém modelu .

v' znalost zakladl systému popsanych v tutorialu UVOD
v Protazeni (Extrude)

v Diry (Hole)

Je nutné pro fungovani ukazkovych dér pouZzivat nastaveni a skici presné dle
ukazky se stejnymi kétami , vazbami , rozméry a volbami.
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Krok c.2 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
a) posunout zelené body na vybrané reference nebo b) kiliknout na zvolené plochy(body, hrany,osy ...) pfi vybirani druhé reference drZet Ctrl

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.2a

Zadefinovat typ a rozmeéry dle obrazku

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.4 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a zaroveri vytvorené osy (pfi vybirani druhé poloZky drzet Ctrl).
Zadefinovat typ a rozméry dle obrazku

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.5

Wyitvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement), nastavit typ (Type) na diru leZici na poloméru(Radial)
a nastavenim referenci(Offset References) pro jeho zakotovani . Kliknout na plochu a osu pfi vybiréni druhé reference drZet Ctrl .

Zadefinovat typ a rozméry dle obrazku

File Edit View Insert Analysis Info Applications Tools Window Help

|pE2Eagi|va d BEGEHEW

B rgaans

=R=0=")

G

H@-WI

Show' Sdmgs'

("} HOLEO1.PRT
{7 BOKORYS
{7 PUDORYS
47 NARYS
ok CSO

-7 Extrude 1

1 Hole 1
’.’ A_12

-1 Hole 2
... @ InsertHere
LY HEHole 3

PLUDORYS

Placement

Surf:F5{EXTRUDE_1)
| Fiip |

Type I Radial = I

Offset References ———————
I BOKORYS:F1(.. Angle  50.00

A_12.F7(DAT... Radius 220.00

Orientation

Dmensmn orientation referenice

‘ llote  Properties

Hs000 7| ,Ejlao.oo

=

@glﬁa@vﬁ?\@ 4“@@“%5’:—%‘

%“D%ﬁ%

m®@

n ¥eo v x




Krok ¢.5 Predefinovat typ (Type) predesié diry (Hole) na diru leZici na priméru (Diameter).

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.7a

Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
a) posunout zelené body na vybrané reference nebo b) kiiknout na zvolené plochy(body, hrany,osy ...) pri vybirani druhé reference drzet Ctrl

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.7b Zadefinovat typ a rozméry dle obrazku.

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢.8

Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .

Zadefinovat typ a rozméry dle obrazku.

| File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.9 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok c.10 V Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok c.11 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok c.12 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.

File Edit View Insert Analysis Info Applications Tools Window Help
[bepaci|lsayaamEem ] |Brgaads ol oo o0
|| @l

Show"l Seltings'l

NoTAg,

L%

PN
3~
K%
Wx
oS
.

(") HOLEO2.PRT
£7 BOKORYS
£7 PUDORYS
£7 NARYS
2éxCs0
77 Extrude 1
" Hole 1
1" Hole 2
" Hole 3
" Hole 4
" Hole 5

& Insert Here
i #HOLE_6

’4-‘9040 VH

0410
Placement ISS.D 'l I_ | e
I Surf:F5(EXTRUDE_1) Fip I 4 EThrough Al ¥ N

Type ILinear V] l:]
Offset References —————————— 25'50,()0 v]_. £

SufFSEXTR.. Offset  550.00 3l
Surf:FS(EXTR... Align ",_;E]
Orierttation

Dimension onentation reference

I I™ Ext Countersink |
m Shape llcie  Properties
‘ UE Ulv @ oo e Wl I Eew

o

11-17




Krok ¢.13 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok c.14 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.

File Edit View Insert Analysis Info Applications Tools Window Help

lBzpagallovay bR ||Brfaadstesil|eaalo s

E

._
N
PR

X
ox
N
M

AEETEY =
Show ¥ Settings ¥
| I .
(7] HOLED2.PRT o
- 7 BOKORYS
-.£7 PUDORYS (st
.£7 NARYS G
& 5{: cso x %
B Extrude 1 1)(,
-"[{" Hole 1 =
T Hole
{1 Hole 4 90
--"[{"Hole 5 ————|
I HOLE_6
@-\{"HOLE_7 DJ
- @ Insert Here
-1 *HOLE_8 -%]—
(@
N
’ 5l
&
S
Placement )
I Suf F5EXTRUDE 1) o | X
Type I Linear 'l Q
Offset Refe
SufF5EXTR... Ofsst  750.00 3l
Surf:FS(EXTR... Align @
Orientation @
Dimension orientation reference
| I™ Ext Countersink —

Y‘Hacurm&meNoterpm

U[E @ yacuyfso  Fgwses =l[{E-| [y [0 Il Yoo [v]x

11-19




Krok ¢c.15 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok c.16a Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
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Krok c.16b Zadefinovat typ a rozméry dle obrazku. Typ je skicovana dira - kde je potreba naskicovat prirez diry dle obrazku.
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Krok c.18 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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i @ Insert Here
BT #Hole 4

11-28




Krok ¢.22 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok ¢.23 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok ¢.24 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .

Zadefinovat typ a rozméry dle obrazku.
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Krok ¢.25 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .

Zadefinovat typ a rozméry dle obrazku.
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12. SAMOSTATNA PRACE - ZNASOBENI PRVKU

CIL

Procvicit si réizné tvorbu poli prvkd ¢i jejich skupin - zaklady tvorby poli v systému PRO/ENGINEER na ukazkovém modelu .

PREDPOKLADY

v' znalost zakladl systému popsanych v tutorialu UVOD
v’ Protazeni (Extrude)
v Diry (Hole)

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Znasobeni prvk( (Pattern)

,-’ﬂ\ Je nutné pro fungovani ukazkovych priklad pouZivat nastaveni a skici pfesné dle
/ e  ukazky se stejnymi kétami , vazbami , rozméry a volbami.
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Krok c.2 Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .

a) posunout zelené body na vybrané reference nebo b) kiliknout na zvolené plochy(body, hrany,osy ...) pfi vybirani druhé reference drZet Ctrl
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Krok ¢.2a

Zadefinovat typ a rozméry pole dle obrazku (pocet prvkd 6 , parametrem pole bude uhlova kota s prirdstkem 60).
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Krok c.2b Vysledek
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Krok ¢.2c

Predefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkd 6 , parametrem pole bude uhlova kota s prirdstkem 60,

smeér druhy: pocet prvkid 2, parametrem pole bude uhlové kdta s prirdstkem 30 a pridmérovd kota s prirdstkem -150).
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Krok c.2d Vysledek
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Krok c.2e Predefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkd 10, parametrem pole bude uhlova kota s prirdstkem 60,
pridmérové kota s prirdstkem -150 a prdmeér diry s prirdstkem -5).
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Krok ¢.2f

Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help
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Krok ¢c.4

Vytvorit skicu (Sketch) na horni plose ve tvaru dle obrazku. Zadefinovat rozméry dle obrazku.

File

Edit View Insert Sketch Analysis Info Applications Tools Window Help
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Krok ¢.5

Wytvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.
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Krok ¢.6a

Vytvorit pole. Zadefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkd 8 , parametrem je kota v ve sméru delsi hrany s prirdstkem 100,
smeér druhy: pocet prvkd 3, parametrem je kota v ve sméru kratsi hrany s prirdstkem 110). Zruste tvorbu nékterych dér pole kiliknutim na Cernou tecku

zmeéni se na bilou.

»

File Edit View Insert Analysis Info Applications Tools Window Help
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* Datum planes wil not be displayed.
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Krok c.6b

Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help
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Datum planes wil not be displayed.
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& Insert Here
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Krok c.6¢c Predefinovat typ (Fill) a rozméry pole dle obrazku (vypinéni obrazce : vyberte preddefinovanou skicu hvézdy , parametrem je vzdalenost prvkd 50;
Dalsi parametry jako uhel a vzdalenost od skici nechte 0). Zruste tvorbu nékterych dér pole kliknutim na Cernou tecku zmeni se na bilou.
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n i o o [ —a_|3 = *3 B = I o § N EmEYR
CHSEGR -0 Y BB W ArRe-Aa@acish 8000+ g ik
= 4 tselected [ Sketch -
[ Fil v | ¥ sketch 1 [ ] il s0.00 | & 000 ~| J&looo . I Ve v | X
References ] Properties
=] — —_—m
o VIR Regeneration option| General - |
Model Tree "ﬁ'v j 7 Use alternate origin
[} POLED2B.PRT +'| Follow leader location
£F BOKORYS
7 PUDORYS Follow surface shape
{7 NARYS
A C50

) Extrude 1

& Insert Here
=1-[22] #Pattern 1 of Hole 1
[ ##sketch 1 0.00

[7 Space 50.00

0.90
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Krok c.6d

Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help

DEZESQE ©-o- Y By B[ 5252 du i

® POLEDZA regeneration completed successfully.

® Feature redefined successfully.
* Base window cannot be closed.

g B
Model Tree F']ﬁ - Iﬁ o
""" £ F BOKORYS

----- {7 PUDCRYS
----- L7 NARYS

5{,‘ cs0

-7 Extrude 1

—1-[z] Pattern 1 of Hole 1
~[Bf Sketch 1

----- “Li" Hole 1 [50]
----- “{i" Hole 1 [76]
----- "{i"Hole 1 [77]
----- "L Hale 1 [108]
----- “{i" Hole 1 [107]
----- "{i” Hole 1 [108]
----- “{i" Hole 1 [110]
----- “{i" Hole 1 [145]
----- {i” Hole 1 [147]
----- “{i" Hole 1 [148]
----- “{i" Hole 1 [150]
----- 1" Hole 1 [1390]
----- i Hale 1 [191]
----- “{i" Hole 1 [193]
----- 1" Hole 1 [194] i
----- “{i" Hale 1 [195]

----- “{i" Hole 1 [196]

----- 1" Hole 1 [240]

----- i Hale 1 [242]

----- “{i" Hole 1 [243]

----- “[i" Hole 1 [245]

----- i Hale 1 [296]

----- “{i" Hole 1 [297]

----- “i" Hole 1 [298]

----- i Hale 1 [300]

----- “{i" Hole 1 [301]

----- “[i" Hole 1 [302]

----- i Hole 1 [361]

----- “{i" Hole 1 [362]

----- "L Hale 1 [430]

Br¥%e-aq@s Es
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PUDORYS
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File Edit View Insert Sketch Analysis Info Applications Tools Window Help
DEE&EGR vt BRBEREB-Fe-AQQdsdshk 6000 ¢ g ifxE
SREEEeEE £ w

# POLED2B reg R .
* Feature redefined successfully.
* Base window cannot be closed.

Model Tree .;ﬂ* % 7

[CJ POLEO3.FRT

840.000
692.00
654.00
551.00

. 3
368.00 2

o 400.000 =
7 4

140.000+ 1 ;

®
253.00 =
100.000 N :

N --v

X
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File Edit View Insert Analysis Info Applications Tools Window Help

DSU&QL v o L BEFEREN Br¥e-AA@40sRk eoo0) g L% »
OSelectasloetch.mmWMSmw.ﬂwtd'ommbefwndhmmpmel) -

® POLEO3 regeneration completed successfully.
® Feature redefined successfully.

© Select items such as Dimensions, Sections, Trajectories, Tolerances, Surface Finish or other features for editing

E <ol
Model Tree ﬁv Egv

P
1

[T S

DRZSBIJIBRE ]
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Krok c¢.10a

Vytvorit pole. Zadefinovat typ a rozméry pole dle obrazku (smér definovan krivkou(curve) : pocet prvkd 7 ) .

File Edit View Insert Analysis Info Applications Tools Window Help

IS8BE&6GQ v - § BRI D Br¥e-aa@edrsh 80 90 - g Ll
L

4 | tselected [ Sketch -]
[cuve  ~| #iisketcn1 | A~ n|7

Il Vigo|v | X
References Properies

=] —

a” % Regeneration option| General -

Model Tree “ﬂ"‘" - ﬁ - Follow surface shape
(] POLEO3APRT

£F BOKORYS

£F PUDORYS

L7 MARYS Follow curve direction

2 C50
g7 Extrude 1

Fa

=+ Insert Here
—-[12] #Pattern 1 of Extrude 2
[ ##sketch 1
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Krok c.10b

Vysledek

File Edit View Insert Analysis Info Window Help

DBEHBGR v-a-f BB

# Base window cannot be closed.

$Select a sketch. (If an internal sketch is preferred, the "Edit” option can be found in the References panel.)
® POLED3A regeneration completed successfully.

® Feature redefined successfully.

Applications  Tools

Prge-aa@odeh 8900

¥ Oa¥ =S
& 't
ox g_ tHi 1 1

& | 1selected Smart

fo & [F

Model Tree

[ POLEO3A.PRT
- F BOKORYS &
- F PUDORYS
- F MARYS
2 CS0 X
-7 Extrude 1 =

1 ’;' A_12 ®
% Sketch 1

B Sketch 1

& Extrude 2 [1]
77 Extrude 2 [2]
Ef?] Extrude 2 [3]
7 Extrude 2 [4]
¢ Extrude 2 [5]
&7 Extrude 2 [6]
&7 Extrude 2 [7]
& Insert Here

R e S S SR
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Krok c¢.10c

Predefinovat typ a rozméry pole dle obrazku (zapnout nastaveni orientace dle krivky (Follow curve direction)).

] POLED3B.PRT W
L £ BOKORYS
£7 PUDORYS

| Follow curve direction

- ap Insert Here
#ipattern 1 of Extrude 2
i....gf:fsketdj 1

File Edit Yiew Insert Analysis Info Applications Tools Window Help
g : i T g [ g3 Oe3 g i = 45 B = o ’ y
S e vre-YBREREENO BrFe-aAQ40sRE oot g ifnE
"2
4 tselected [ Sketch -]
Curve * | % sketen 1 | 180.00 n v &:ﬁ"x
References | Properties
=} =
a° % Regeneration option| General -
Model Tree ‘ﬁ’v = Follow surface shape

ary
P
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Krok ¢.10d Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help
i ~ - i L mE [ Oad Ogd guw [c—o | |E = + AE = i ] vy [0
DEL&GL v-a- Y BERERN - Dr%e-Aa@stesh o090 gl
# Base window cannot be closed.

@ Select a sketch. (If an internal sketch is preferred, the "Edit” option can be found in the References panel.)

® POLED3B regeneration completed successfully.
#* Feature redefined successfully.

% 1 selected [ Smart
B
Model Tree “]ﬁv | -

[l POLED3B.PRT
----- {7 BOKORYS
----- {7 PUDCRYS
----- £7 NARYS
Hgp? Extrude 1
e i A_12

+ -GV Extrude 2 [1]
+|j1] Extrude 2 [2]
-7 Exctrude 2 [3]
'Ef_'ﬂ Extrude 2 [4]
+ - Extrude 2 [9]
-7 Extrude 2 [€]
----- = Insert Here
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1000.0

12-27




() HOLEO1.PRT
i {7 BOKORYS

—

PUDORYS
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Krok c.12 Wytvorit vystupek vytaZenim obdélnikového profilu (60x20) (Extrude).

File Edit View Insert Analysis Info Applications Tools Window Help

i r i bopEn [N Oa3 043 == |H = + RE = i 7 ¥, i
DEE&GE o - § BRHEIEW DT HBrRFe- A0 48l 00 @@% ;;LZ;,Z—Y,?;; 2
$ Select Edit Value or Properties to edit selected temis)

@ Select Edit Value or Properties to edit selected temis)

@S»elect items =uch as Dimenzions, Sectiong, Datume, Features, Cosmetics for editing

% 1 selected All
Eo

Model Tree "ﬁv i -

o
o Chamfer 1
i wp Insert Here
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| File Edit View Insert Analysis Info Applications Tools Window Help

DEHSAR v o § BB HIEE WD

q LR

‘n'ﬁ ® Shaded mode! will be displayed ‘ 8 \ [

"]
\?? [DxD  ~| D240 - n IZIGd‘x \

Sets Transitions Pieces Options Properties

IR -NC)
Model Tree S R

1% e-aa@bFeh 0000

v

f

I

g7 Extrude 1
;,.....l,’ A_12
G- g7 Extrude 2
oy Insert Here
iy ¥ Chamfer 1
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Krok c.13b

Model s vystupkem

File Edit View Insert Analysis Info Applications Tools Window Help

DEEsQ R

@ Select Edit Value or Properties to edit selected item(s)
$ Select Edit Value or Properties to edit selected item(s)
@Selec‘t tems such as Dimensions, Sections, Datums, Features, Cosmetics for editing

fe Y
Model Tree ﬁv Igv

Brfe -aca@is R 8aa0e 2l e

Smart
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File Edit View Insert Analysis Info Applications Tools Window Help

. 3 3 2 OaF Oy
DEE &G -~ ¢ B [[35EEE MW
®* Feature redefined successfully.
# Base window cannot be closed.
* Base window cannot be closed.
®* Group LOCAL_GROUP has been created successfully.

[ &

Br¥e-aaAQs sl 09000 2 LkufE e

| 3 |25e|eded [ smart

Model Tree T~ =

[J POLEC4.PRT

-4 F BOKORYS
+-£F PUDORYS .
£F NARYS |
A cs0 x
| x ¥ L3
- Extrude 1
{ a_12 K
eAdExirude 2| z .
T
.? InsertHd ~ Representation ] [Em
Delete &
Group
Suppress
Edit
Dynamic Edit

Create Driving Dimension AE

Edit Parameters

1
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Krok c¢.15a Vytvorit pole. Zadefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkid 4 , smérem je delsi bocni hrana s prirdstkem 200;
smeér druhy: pocet prvkid 2, smérem je kratsi bocni hrana s prirdstkem 250).

File Edit View Insert Analysis Info Applications Tools Window Help

£ o Y BEREEFND BrFe- A4 TR 8000 2 L%

& | 1selected [AII 'l
Direction | | 1|+ »| 1Edge o |a 20000 v | 2+ ~||[1Edge 5 |2 25000 ~ n «-acﬁ)(

Properties

o\ IE &

Model Tree "ﬁ" = -

(] POLED4A.PRT
+-{F BOKORYS
£F PUDORYS

- o Insert Here
4[] #Pattern 1 of LOCAL_GROUP

12-33




File Edit View Insert Analysis Info Applications Tools Window Help

DSEOAR - BRTEENT

® Base window cannot be closed.
o Select a Plane, Flat Face, Linear Curve, Csys Axis or axis to define the first direction.
® Specified section has been removed.
m1mm:mmmm@;mm.mmbmm. l & I

Ao S
Model Tree ﬁﬂ, jv

(J POLEO4APRT

.7 BOKORYS

Brge-aa@dsrsh o000t g if%bE v

[ Smart

-7 Extrude 1

E—J Pattern 1 of LOCAL_GROUP
[+ &9 Group LOCAL_GROUP

[+-&9 Group LOCAL_GROUP_1
[+-&9 Group LOCAL_GROUP_2
[+-&9 Group LOCAL_GROUP _:

&9 Group LOCAL_GROUP_6
[+-&9 Group LOCAL_GROUP _:
----- # Insert Here bt
-

&
i
S

DRI S RivobRE = 0.85.0 %%
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PUDORYS
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File Edit View Insert Sketch Analysis Info Applications Tools Window Help
D wl%q%“n c-y BN BrFe-aads sk 8900 ¢ 2 LAE%E
CRREEEEerS £

OSpeaﬁedsednnhnheenmved.
Line 1 part POLEO4A: Model changed since mass props calculated. Iayneodbmedum.
* Base window cannot be closed.

35.000

100.000 100.000 o
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Krok c.18

Wytvorit vystupek vytaZenim obdélnikového profilu (60x20) (Extrude)

File Edit View Insert Analysis Info Applications Tools Window Help

DEEBAR v -c- Y RBELERMG BrFe-Qa@ad

$Select Edit Value or Properties to edit selected tem(s)
$Select Edit Value or Properties to edit selected tem(s)
o Select items such as Dimensions, Sections, Datums, Features, Cosmetics for editing

B iCNL=]
Model Tree “ﬁv j v

(] POLEDS.PRT
£7 BOKORYS
£7 PUDORYS
£7 NARYS
2éxcso

+-¢77 Extrude 1

‘o 88 g0

& | 1selected

All
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Krok ¢.19a Vytvorit pole. Zadefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkd 3 , smérem je cara skici s prirdstkem 181; smér druhy: pocet prvki
4, smérem je cara skici s prirdstkem 77). Zména v prvnim sméru : sitky prvku (60) s prirdstkem -20, vysky(40) s prirdstkem 25. Zména v druhém
sméru : vysky (40) s prirdstkem 10.

File Edit View Insert Analysis Info Applications Tools Window Help

5 e oo yBEREEEND Arfe-aaQacdield aaa0e g ilulE

4 tselected  [al - |
[Direction = | | 1f++ +] 1Edge BE 181.00 < | | 2o «| 1Edge %4 77.00 - I Viso | v | X

l Options  Properties

Direction 1

Dimension Increment
d245:F-1(EX... -20.00
d243:F-1(EX... 25.00

Define increment by relation

Direction 2
Dimension Increment
d243:F-1(EX... 10.00

Define increment by relation
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Krok c.19b Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help

D& Q!

Dr®e-Qa@A

oo g

ﬂ> Select dimensions to vary in the first direction.
$Sehd dimensions to vary in the second direction.
* Specified section has been removed.
Line 1 part POLEOSA: Model changed since mass props calculated. May need to recalculate.

b G

Model Tree i B~

(] POLEOSA.PRT
£7 BOKORYS
£7 PUDORYS
L7 NARYS

7% Sketch 1
= Pattern 1 of Extrude 2
+-¢7) Extrude 2 [1, 1]
Efj Extrude 2 [2, 1]
7 Extrude 2 [3, 1]
&7 Extrude 2[1, 2]
7 Extrude 2 [2, 2]
7 Extrude 2 [3, 2]
&) Extrude 2 [1, 3]
&7 Extrude 2[2, 3]
7 Extrude 2 [3, 3]
& Extrude 2 [1, 4]
+-7) Extrude 2 [2, 4]
+ Efj Extrude 2 [3, 4]
& Insert Here

- {F -

v

Y BER

%

Lol
&

DR 2 -
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PUDORYS
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Krok ¢.21 Vytvorit osu v priseciku rovin BOKORYS a PUDORYS

File Edit View Insert Analysis Info Applications Tools Window Help

2 i oo ERBEERPH BrFe-a@00ahE

ooo

56 g0

alakE
E A?

@ Select up to 2 references, such as plane, surface, edge or point to place axis. - 2 selected [ All

Ao [

Model Tree C]ﬁ Z 13 Z Placement |Display | Properties P
[ POLEDEB.PRT References R
..... 7 £
el F PUDORYS:F2(DAT... Through ~
3‘5{;2;?5 BOKORYS:F1(DATU... Through
7 Extrude 1 "x* .
=% Offset references "
& Insert Here _K,
o, z
HETRT] .
EA)
s

Cancel

—~
=
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Krok ¢.22

Wytvorit vystupek vytaZenim obdélnikového profilu (60x20) (Extrude).

File Edit View Insert Analysis

Info Applications Tools Window Help
DEE&EQR ©-o- Y BE BN

® Axes will be displayed.

a =
A =
Model Tree T A= R
(CJ POLEO6B.PRT
£7 BOKORYS
{7 PUDORYS
£7 NARYS
2¢xCs0
-5 Extrude 1
a1 L
- Extrude 2
& Insert Here

= |

- BArfe-aqa@ns Ptk 8000 gl w

& | 1selected

A_12
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File Edit View Insert Analysis Info Applications Tools Window Help

DEES&Q.

® Base window cannot be closed.
® Select tems such as Dimensions, Sections, Trajectories, Tolerances, Surface Finish or other features for editing

® Axes will be displayed.

T Ix. % [T
FAY ST

- Arfe-aQa@stshk 8000

® Datum planes will be displayed.
8 Smart

Ao

Model Tree i~ B

(] POLEDS.PRT
£7 BOKORYS
£7 PUDORYS
£7 NARYS
2xCs0

+ ¢y Extrude 1
S AR

¢4 Extrude 2
P Insert Here
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Krok ¢.23a Vytvorte pole. Zadefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkd 6 , smérem je osa nadefinovana v pridseciku dvou hlavnich rovin

vytvorend pred vystupkem - prirdstek neni definovan - prepnout na volbu vypinit uhel (ikona Uhblu) a zadat 360 stuprid; Zruste tvorbu nékterych dér
pole kliknutim na cernou tecku zmeni se na bilou.

File Edit View Insert Analysis Info Applications Tools Window Help

i@ oo Y’ CEwl Brfe-aca@sFasi

fi¥

dgo

8600

ooo

D & | 1selected
[ Axis v | | 1 1item(s) 5% |6 /% | 360.00 v| |21
Dimensions Options-| Properties

= = —
g % Regeneration option| General v |
__An e
Modei Tree T~ B Follow axis rotation
(7] POLEOSA.PRT
£7 BOKORYS
£7 PUDORYS
£7 NARYS
2¢x CS0

-4 Extrude 1
+ ¥

+- (2] #Pattern 1 of Extrude 2
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Krok ¢.23b Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help

D2E&Qe v - Y BREHEEWMI Br®

+,  —AE = i i 4 i
¢-aa@ats@E 0000 [QliF)
@Select a Datum Axis, Ceys Axis to define the pattern center.
* Specified section has been removed.

® POLEDSA. regeneration completed successfully.
* Feature redefined successfully.

% 1 selected
Be WY
Model Tree '-'ﬁ’ - 13 o

2T
[TJ POLEOSA.PRT
----- #7 BOKORYS

----- £7 PUDORYS
----- £7 NARYS
3{, cs0

-gf) Extrude 1
----- Fan

Smart v l

+E(_'J Extrude 2 [1]
+|j_"] Extrude 2 [2]
+|:(_ﬂ Extrude 2 [4]
-7 Extrude 2 [5]
----- = Insert Here

12-47




Krok ¢.24a

Vytvorte pole. Zadefinovat typ a rozméry pole dle obrazku (smér prvni: pocet prvkid 6 , smérem je osa nadefinovana v prdseciku dvou hlavnich rovin

vytvorend pred vystupkem - prirdstek neni definovan - prepnout na volbu vypinit uhel (ikona uhblu) a zadat 360 stuprid; Zapnout nastaveni orientace
dle krivky (Follow curve direction)

File Edit View Insert Analysis Info Applications Tools Window Help

O i 0o BBEEEEND BrFe-2A2AQQA4 sk 80090 ¢ [glY%uE

"

& & |1selected [ Al v |
[ Axis v | | 1 1item(s) % |6 : - /& | 36000 v| | 2[4 v n v vfhjf@x
Dimensions | | Properties

ga Iy
Model Tree "ﬂ v _:J -

(7} POLEOSB.PRT
£7 BOKORYS
£7 PUDORYS
£7 NARYS
2¥xCs0

+-¢7) Extrude 1
ik
h

Regeneration op’tion[ General v

| Follow axis rotation

K12
& Insert Here
+- (i) #Pattern 1 of Extrude 2
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Krok ¢.24b

Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help

DSE&S&S QL v - ¥ BB HEE W

® POLEOGA regeneration completed successfully.

® Feature redefined successfully.
* Base window cannot be closed.

g W

Model Tree

'-'ﬁ’v =
=

=-[:) Pattern 1 of Extrude 2

+|:(_'J Extrude 2[1]

----Ef_.’] Extrude 2 [2]

i --Ef_,'] Extrude 2 [3]

+ --E[_:] Extrude 2 [4]
+|j1] Extrude 2 [3]
- Extrude 2 [8]

----- & Insert Here

O Brfe-aa@sdshR 80 00

i 7 v,
| AR & L

Smart
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1000.0
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PUDORYS
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Krok c.26 Wytvorit vystupek vytaZenim obdélnikového profilu (60x30) (Extrude).

File Edit View Insert Analysis Info Applications Tools Window Help

D2P&GR v-a-§ BREEREN

@ Select Edit Value or Properties to edit selected tem(s)
@ Select Edit Value or Properties to edit selected tem(s)
@Seled tems such as Dimensions, Sections, Datums, Features, Cosmetics for editing

& | 1selected All

fo WP+
Model Tree ﬁv@v

[J POLEOT.PRT
i 7 BOKORYS
o 7 PUDORYS
&7 NARYS

Secso

-] Extrude 1

i

e a2 )
f'"tf-«d

“.-wp Insert Here A

7
o
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Krok ¢.27a Wytvorte pole. Zadefinovat typ a rozméry pole dle obrazku (fizeno tabulkou - vyberte vSechny koty (Table dimensions) vystupku a dopinte tabulku
pomoci tlacitka EDIT )

File Edit View Insert Analysis Info Applications Tools Window Help

g oo Y BB EIE M

&) Editing pattern table TABLET. @ [ Smart i ]
Table ~| Sitem(s) Active table | TABLE1 = | [ n e X
Table Dimensions Tables Options Properies
Ba 4247.FI(EXTR. *
d246:F9(EXTR. =
Maodel Tree (

d244:FO(EXTR.
[ POLED7A.PRT

& Insert Here
(1] #Pattern 1 of Extrude 2

.ProITABLE TM Wildfire 5.0 (c) 2010 by Parametric Technology Corp — |Elli|

File Edit View Format Help

C1 C2 C3 c4 C5 Ch Cc7

- RS ! Table name TABLEA.
R10 | 1 B
R11  lide d247(560.000) d246(280.000) d244(30.000) d245(60.000) d243(20.00)
R12 1 350.000 * 15.000 70.000 5.00 5
R13 2 440.000 180.000 23.000 60.000 * = )
R14 3 680.000 260.000 80.000 30.000 35.00 ]
R15 4 230.000 260.000 80.000 30.000 * Eb
R16 5 530.000 350.000 22000 120.000 * _/\
R17 6 380.000 80.000 8.000 160.000 20.00 "/
R18 7 330.000 330.000 22.000 120.000 *
R19
C1R1:
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File Edit View Insert Analysis Info Applications Tools Window Help

D2P&eGe v o $BREERRD BrFe-AAA4sR 8000 i

-

,.ﬁ
wx
M|

3

¢d

* Specified section has been removed.

* Regenerating POLEOTA feature 8 out of 16 ...
* POLEOTA regeneration completed successfully.
® Feature redefined successfully.

o)

| 8 | 1sslected [ Sman

ModelTree i~ I~
] POLED7A.PRT
----- £7 BOKORYS
----- £7 PUDORYS

x

=
x
-

H |
-

=R JPattern 1 of Extrude 2
.77 Extrude 2 [1]

x

) Extrude 2 [7]
[ Extrude 2 [8]
----- = Insert Here

rﬂﬂ@rﬂf%é

2 L
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13. SAMOSTATNA PRACE - FAMILY TABLE

CiL

Procvicit si tvorbu dilG fizenych tabulkou - zaklady tvorby odvozenych dild v systému PRO/ENGINEER na ukazkovém modelu .

File Edit View Insert Analysis Info Applications Tools Window Help

DEHSGR v o BREREND BrFe-aa0bsdkshk 800t BERKRE »

ion o7 of feature 8 (CUT), model POJISTKA_DIN_6759.
e displayed without tolerances.

BA o
ModelTroe A7 |
() POJISTKA_DIN_6799.PRT
{7 BOKORYS
L7 PUDORYS
7vars
Bacso
-5 Protrusion d 45
B Cutid 77
“PRoundid 131

8 Al

gz

ERR R A

File Edit Insert Parameters Ullities Show

E
Ix

Lookln

(Pan RIS [jPoJ\STKAVD\N‘WQs v]

o BB X (2 08

- | D4=B210.2

D6=D4
D7=(B2+B3)2)"1.1

c_hmotnost=ceil(mp_mass(")3)
I an mass props calculated. May need to recalculate.

DHZ D JoBRA -

PREDPOKLADY

v znalost zaklad{ systému popsanych v tutorialu UVOD
v Protazeni (Extrude)
v Odfiznuti (Cut)

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Odvozené modely Fizené tabulkou (Family Table)

Je nutné pro fungovani ukazkovych priklad(l pouZivat nastaveni a skici presné dle
ukazky se stejnymi kétami , vazbami , rozméry a volbami.
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File Edit View Insert Sketch Analysis Info Applications Tools Window Help
D2E802 oo YERHRE] ErFe-aa@sdsh @00 ¢ ¢ [GEFEER

Lt

v

A\ v

£ 30

-
-

4.25

x
x

Mot - '
% LS
.
o

-

tWlsxestson/F
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File Edit View Insert Skek:h Analysis Info Applicalions Tools Window Help

sk 68600 ¢

AR

%A 4 C A

Placement Options Properties

18|

Model Tree RN

[j POJISTKA_DIN_6799.PRT
{7 PRAVA

+£7 PREDNI

g7 Protrusion id 45

e -} Insert Here

&P ¥cu
[ 5200002

-

»

=
+
N
-
o
v
X
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S:CENERIC
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File Edit View Insert Sketch Analysis Info Applications Tools Window Help
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Krok ¢.2f

Vysledek

File Edit View Insert Analysis Info Applications Tools Window Help

DBSUBGR o c-yanmEEEn BrFe-aa@s e

® Coordinate Systems will not be displayed.

® POJISTKA_DIN_6799 has been saved.
® Showing dimension d7 of feature 8 (CUT), model POJISTKA_DIN_6799.
* Dimensions will be displayed without tolerances.
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{7 POJISTKA_DIN_6799.PRT
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¢) | «xModel changed since mass props calculated. May need to recalculate.
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Krok ¢.3 Vytvorit novou soucast vytaZenim nasledujiciho profilu (Extrude)

File Edit View Insert Analysis Info Applications Tools Window Help

DEEHSGe o - Y BRERLEEM- Br®e-aa@sodsk oo a0 Qlld%fE »

® Showing dimension d1 of feature S (PROTRUSION), model POJISTKA_DIN_6799.
[E]cannot add a parameter existing in a parent table of this object.

® Showing dimension d0 of feature 5 (PROTRUSION), model POJISTKA_DIN_6799.
ElCannot add a parameter existing in a parent table of this object. ‘ 3 ’

—
B\
ModelTree 4 v [~

@ §POJISTKA_DIN_6799.PRT]

+-£7 BOKORYS

{7 PUDORYS

{7 NARYS

B Cs0

B¢y Protrusion id 45

g Cutid 77

) Round id 131

i-gr) Cutid 199
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@ Parameters ;Ig]ﬂ :
File Edit Parameters Tools Show DZ
— LookIn — IE]
(Part ~ ]| & [ 3PousTKa DIN 6799 -] =
Filter By | Default ~ | | Customize... A
Name Type Value Desig.. Access Source @
m String ] @G?Fuﬂ User-Defined 11,
B1 String 2-25 = @E?Fuu User-Defined ®
M String 0.44 o BaFul User-Defined 3
N Real Number  0.800000 aé\Full User-Defined _Q
B4 Real Number  1.200000 E] %ﬂwFuH User-Defined ; i A
NORMA String DIN 6799 m @c‘?Full User-Defined OD%
PTC_MATERIAL_NAME String OCEL ] @'ﬁ-FuII User-Defined %
C_HMOTNOST Real Number  0.001000 [} eLocked Relation :5)
-
*+ - [Main ¥ ] Properties... ﬂfﬂj “
Reset | | Cancel
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Krok ¢c.4

Vytvorit skicu (Sketch) na horni plose ve tvaru dle obrazku. Zadefinovat rozméry dle obrazku.

File Edit View Insert Analysis Info Applications Tools Window Help

DBEH8ORQR v - BBREHIEEMIT-

® Showing dimension d0 of feature 5 (PROTRUSION), model POJISTKA_DIN_6799.
ElCannot add a parameter existing in a parent table of this object.
® Showing dimension d1 of feature 5 (PROTRUSION), model POJISTKA_DIN_6799.
E]Cannot add a parameter existing in a parent table of this object.

[ 8 GENE

ModelTree  Sfff ~ (3~ ‘

(] POJISTKA_DIN_6799.PRT
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& Insert Here
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Krok ¢.5 Witvorit diru (Hole) vybranim horni plochy pro umisteni diry(Placement) a nastavenim referenci(Offset References) pro jeho zakotovani .
Zadefinovat typ a rozméry dle obrazku.

B Family Table :POJISTKA_DIN_6799 7 ;Iglll

File Edit Insert Tools

Look In: POJISTKA_DIN_6799] -l @& % 0| S 0f W oo B @0 T
Tpe  InstanceName ~CommonN.. o) B1 e M N i B4 ROZMER

POJISTKA_DIN... 15 2-25 0.4 0.44 0.8 4.25 12

DIN6799_1_2 12 14-2 0.3 0,34 0.6 3.25 12 KROUZEK 1,2
DIN6799_1_5 15 2-25 0.4 0,44 0.8 4.25 15 KROUZEK 1,5
DING799_1_9 1.9 25-3 05 0,54 1.0 4.80 19 KROUZEK 1,9
DIN6799_2_3 23 3-4 0.6 0,64 1.0 6.30 23 KROUZEK 2,3
DIN6799_3_2 32 4-5 0.6 0,64 1.0 7.30 3.2 KROUZEK 3,2
DING799_4 40 5-7 0.7 074 12 9.30 40 KROUZEK 4
DIN6799_5 5.0 6-8 0.7 0,74 12 11.30 5.0 KROUZEK 5
DING799_6 6.0 7-9 0.7 0,74 12 12.30 6.0 KROUZEK 6
DING799_7 7.0 8-11 0.9 0,94 15 14.30 7.0 KROUZEK 7
DING799_8 8.0 9-12 1.0 1,05 18 16.30 8.0 KROUZEK 8
DIN6799_9 9.0 10-14 1.1 1,15 20 18.80 9.0 KROUZEK 9
DING799_10 10.0 11-15 12 1,25 20 20.40 10.0 KROUZEK 10
DING799_12 12.0 13-18 13 1,35 25 23.40 12.0 KROUZEK 12
DIN6799_15 15.0 16-24 15 156 3.0 20.40 15.0 KROUZEK 15
DING799_19 19.0 20-31 18 18 35 37.60 19.0 KROUZEK 19
DING799_24 24.0 25-38 2.0 2,05 40 4460 24.0 KROUZEK 24

oK Eier Ope Cancel
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